Epson® PowerLite® 835p
Multimedia Projector

User’s Guide
Important Safety Information

WARNING: Never look into the projector lens when the lamp is turned on; the bright light can damage your eyes. Never let children look into the lens when it is on. Never open any cover on the projector, except the lamp and filter covers. Dangerous electrical voltages inside the projector can severely injure you. Except as specifically explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified service personnel.

WARNING: The projector and its accessories come packaged in plastic bags. Keep plastic bags away from small children to avoid any risk of suffocation.

Caution: When you replace the lamp, never touch the new lamp with your bare hands; the invisible residue left by the oil on your hands may shorten the lamp life. Use a cloth or glove to handle the new lamp.

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of Seiko Epson Corporation. The information contained herein is designed only for use with this Epson product. Epson is not responsible for any use of this information as applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation’s operating and maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original Epson Products or Epson Approved Products by Seiko Epson Corporation.

Epson, Quick Corner, and Wall Shot are registered trademarks and Exceed Your Vision, Easy Management, and EasyMP are trademarks of Seiko Epson Corporation.

PrivateLine, Presenters Club, and PowerLite are registered trademarks; SizeWise is a trademark; and Epson Connection, Epson Store, and Extra Care are service marks of Epson America, Inc.

Pixelworks, DNX, and the DNX logo are trademarks of Pixelworks, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. Epson disclaims any and all rights in those marks.
Contents

Welcome ................................................. 9
Using Your Documentation ............................. 10
    Getting More Information ....................... 10
Registration and Warranty ........................... 11
Unpacking the Projector ............................... 12
    Additional Components ........................... 12
    Optional Accessories ............................. 13

1 Displaying and Adjusting the Image ............. 15
Positioning the Projector ............................ 16
Projecting the Image .................................. 18
    Turning On the Projector ....................... 18
    Selecting the Image Source .................... 20
Troubleshooting Display Problems .................. 21
    You Can’t Project an Image .................... 21
    The Projector and Notebook Don’t Display the
    Same Image ........................................ 21
Adjusting the Image ................................... 24
    Adjusting the Height of Your Image .......... 24
    Using Quick Setup ............................... 25
    Focusing and Zooming Your Image ............ 25
    Adjusting the Image Shape ..................... 26
    Correcting Computer Images .................... 28
Shutting Down the Projector ......................... 29
Using the Direct Power ON Function ............... 30
2 Using the Remote Control
- Turning On and Using the Remote Control
- Replacing the Batteries
- Controlling the Picture and Sound
- Switching Between Picture Sources
- Previewing Picture Sources
- Adjusting the Image Shape
- Turning Off the Picture and Sound
- Stopping Action
- Zooming Part of Your Image
- Displaying a Picture-in-Picture Video
- Controlling the Volume
- Projecting Images Without a Screen
- Making Initial Color Corrections
- Adjusting Color Corrections for a New Surface
- Operating Your Computer with the Remote Control
- Highlighting Your Presentation
- Using the Pointer Tool
- Customizing the Pointer Tools

3 Connecting to Computers, Cameras, and Other Equipment
- Connecting to a Computer
- Connecting to the Computer Ports
- Using the Macintosh Desktop Adapter
- Connecting the Cable for Remote Mouse Control
- Connecting an External Monitor
- Connecting to Video Equipment
- Connecting a Composite Video Source
- Connecting an S-Video Source
- Connecting a Component Video Source
- Connecting an RGB Video Source
- Connecting to a Digital Camera or Other Device
- Removing the USB Cable
- Playing Sound Through the Projector
- Connecting Audio Equipment to the Projector
- Connecting External Speakers
4 Presenting Through a Wireless Network

Starting EasyMP .................................................. 60
Configuring the Connection ................................. 62
  Using Ad Hoc Mode ........................................... 62
  Using Access Point Mode ................................. 68
Using Wireless Security Options .......................... 79
  Adding WEP Encryption ..................................... 80
  Adding WPA Security ....................................... 81
  Adding LEAP Authentication ......................... 82
Projecting Wirelessly ......................................... 83
  Using the Control Bar ...................................... 87
  Connecting in IP Connect Mode ....................... 89
  Switching Between Users ............................. 92
Removing the Wireless 802.11g Card ..................... 93

5 Presenting from a Memory Card,
Digital Camera, or External Drive .................. 95
Inserting a Memory Card in the Projector .......... 96
  Removing a Memory Card ................................ 96
Creating a Slideshow on the Fly ......................... 97
  Displaying the Slideshow ................................ 97
  Controlling Your Slideshow .............................. 97
  Changing Timing and Other Settings .............. 98
Presenting Image Files From a Digital Camera .... 99
Presenting Image Files From an External Drive ...... 100
Creating a Scenario .............................................. 102
  Converting a PowerPoint File to a Scenario ........ 102
  Creating a Scenario from Scratch .................... 104
Transferring Your Scenario to a Memory Card ...... 111
Presenting Scenarios ........................................... 113
  Controlling Your Scenario ............................. 114
  Editing Your Scenario on the Projector .......... 114
Supported File Formats ..................................... 116
## Fine-Tuning the Projector

- Using the Menu System ........................................ 118  
  - Restoring the Default Settings ............................ 119  
- Adjusting the Image Quality .................................. 120  
  - Adjusting the Image ........................................ 120  
  - Adjusting Signal Settings ................................. 121  
- Adjusting the Image Size, Shape, and Position .......... 123  
- Adjusting the Color .......................................... 125  
- Adjusting the Sound ......................................... 126  
- Using the Projector Security Features ................. 126  
  - Enabling Password Protection ........................... 127  
  - Creating Your Own Startup Screen ................... 130  
  - Disabling the Projector’s Buttons .................... 131  
- Controlling Multiple Projectors ......................... 132  
  - Setting the Projector ID ................................ 132  
  - Changing the Remote Control ID ..................... 133  
- Customizing Projector Features ......................... 134  
  - Remote Monitoring Setup Options .................. 134  
  - Miscellaneous Setup Options ......................... 134  
  - Enabling Sleep Mode ................................... 134  
  - Enabling Quick Setup Options ....................... 135  
    - Automatically Running Quick Setup ............. 136

## Managing Projectors

- Connecting and Configuring the Projector on a Network .... 138  
- Using EMP Monitor .......................................... 139  
  - Opening and Closing EMP Monitor .................. 139  
  - Registering Your Projectors ............................ 140  
  - Monitoring Your Projectors ............................ 142  
    - Controlling Your Projectors ....................... 144  
- Using E-mail Alerts ......................................... 145  
- Understanding the Notification Messages ............... 148  
- Using a Browser to Monitor Projectors ................... 149
Using Projector Groups .......................................................... 151
Creating a Group ................................................................. 151
Connecting to a Projector in a Group ................................. 154
Exporting a Projector Group .................................................. 156
Importing a Projector Group .................................................. 158

8  
**Maintaining the Projector** ..................................................... 161
Cleaning the Lens ................................................................. 162
Cleaning the Projector Case ................................................... 162
Cleaning the Air Filters and Vents ......................................... 162
Replacing the Lamp and Air Filters ........................................ 163
  Resetting the Lamp Timer .................................................. 165
Transporting the Projector ...................................................... 166

9  
**Solving Problems** ............................................................. 167
Using On-Screen Help .......................................................... 168
Checking Projector Status ..................................................... 169
  What To Do When the Lights Flash ................................. 169
  Viewing Lamp Usage and Other Information .................. 171
Solving Problems with the Image or Sound ....................... 171
Solving EasyManagement Problems ................................... 177
Solving Problems with the Remote Control ....................... 181
Where To Get Help ............................................................... 181
  Internet Support ............................................................... 181
  Speak to a Support Representative ..................................... 182

A  
**Software Installation** .......................................................... 183
Windows System Requirements ........................................... 183
Macintosh System Requirements .......................................... 184
Installing the Software on a Windows System ................... 185
Installing the Software on a Macintosh ............................. 186
B

Projector Installation ......................... 187

C

Technical Specifications ......................... 189
  General ........................................... 189
  Projection Lamp ................................ 190
  Remote Control ................................ 190
  Dimensions .................................... 190
  Electrical ...................................... 190
  Environmental ................................ 190
  Safety .......................................... 191
  Compatible Video Formats .................... 191

D

Notices ............................................. 193
  Important Safety Instructions ............... 193
  Remote Control Information ................. 195
  Declaration of Conformity ................... 196
  FCC Compliance Statement .................. 197
  Warranty ........................................ 198

Index .............................................. 201
Welcome

The Epson® PowerLite® 835p is an easy-to-use, lightweight projector that offers up to 3000 lumens of brightness and a 600:1 contrast ratio for incredibly vivid images and clear text.

Versatility
You can connect it to a wide range of computers and video sources, or you can project over an 802.11g or 802.11b wireless network or a wired LAN network.

Ease of use
The projector’s keystone correction and Quick Corner™ features automatically correct image distortion, and Epson’s unique Wall Shot™ function lets you project against blackboards and colored walls without loss of image color, regardless of ambient lighting. The projector also automatically focuses the projected image. These features can all be set to automatically create the best image projection by pressing a single button.

Complete control
Use the remote control to take charge of your presentation. Freeze the action, zoom in on part of the picture, or display a picture-in-picture video. Use the remote as a pointer, or to draw on the screen. You can even use it in place of your computer’s mouse to control your computer and change slides in Microsoft® PowerPoint®.

EasyManagement
With the projector’s EasyManagement™ system, you can use a Windows® PC to remotely monitor and control the projector over a network.

Security
To prevent unauthorized use, this projector includes several security features including a password, user’s logo, and the ability to lock the projector buttons.
Using Your Documentation

This book contains all the information you need to set up and use your projector. Please follow these guidelines as you read through it:

- **Warnings** must be followed carefully to avoid bodily injury.
- **Cautions** must be observed to avoid damage to your equipment.
- **Notes** contain important information about your projector.
- **Tips** contain additional projection hints.

Getting More Information

Need tips on giving presentations? Quick steps for setting up your projector? Here’s where you can look for help:

- **presentersonline.com**
  Includes a library of articles covering presentation tips, tricks, and technology. The site provides templates, clip art and sound clips, as well as Presenters Services to use on the road. Even more resources and services are available if you register to join the Presenters Club®—and it’s free.

- **Quick Setup sheet**
  Gives you the instructions you need to get your projector up and running if you are connecting to a notebook, PowerBook®, or iBook® computer.

- **Start Here kit**
  Includes this User’s Guide, your Quick Setup sheet, warranty brochures, and Epson PrivateLine® Support card. Keep the folder with your projector at all times.

- **Built-in help system**
  Provides assistance for common problems. Available from the Help button on the projector or the remote control. See page 168 for details.

- **support.epson.com**
  Download FAQs and e-mail your questions to Epson support.
If you still need help after checking this User’s Guide and the sources listed above, you can use the Epson PrivateLine Support service to get help fast. Call (800) 637-7661 and enter the PIN on the card in your Start Here kit. Or take advantage of Epson’s automated support services 24 hours a day. See page 181 for more information.

Registration and Warranty

Your projector comes with a basic carry-in warranty as well as an international warranty that let you project with confidence anywhere in the world. For details, see page 198 and the warranty brochure included in your Start Here kit.

In addition, for customers who register their projector, Epson offers free Extra CareSM Road Service. In the unlikely event of an equipment failure, you won’t have to wait for your unit to be repaired. Instead, Epson will ship you a replacement unit anywhere in the United States or Canada, usually via overnight delivery. See the brochure in your Start Here kit for details.

To register, simply fill out the registration card included in your Start Here kit and mail it to Epson. Or you can register online at http://www.epson.com/webreg. Registering also lets you receive special updates on new accessories, products, and service.
Unpacking the Projector

After unpacking the projector, make sure you have all the parts shown below:

![Image of projector and accessories]

Save all packaging in case you need to ship the projector. Always use the original packaging (or the equivalent) when you need to send the projector to another location. If you are moving the projector by hand, use a carrying case. See page 13 for ordering information, and page 166 for transportation instructions.

Additional Components

Depending on how you plan to use the projector, you may need additional components:

- To receive an S-Video signal, you’ll need an S-Video cable. One may be provided with your video equipment, or you can purchase one from Epson; see page 13.

- To receive a component video signal from a VCR or other video device, you’ll need a component video cable. You can purchase one from Epson; see page 13.
Some older PowerBooks® and Macintosh® desktop models may need the Macintosh desktop adapter set shown on page 48 (available from Epson; see below.) Older iMac® systems may need a special adapter to provide a VGA output port; see your computer dealer.

**Optional Accessories**

To enhance your use of the projector, Epson provides the following optional accessories:

<table>
<thead>
<tr>
<th>Product</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Replacement lamp</td>
<td>V13H010L31</td>
</tr>
<tr>
<td>Air filter replacement set</td>
<td>V13H134A07</td>
</tr>
<tr>
<td>ATA molded hardshell case</td>
<td>ELPKS35</td>
</tr>
<tr>
<td>Samsonite® wheeled soft case</td>
<td>ELPKS52</td>
</tr>
<tr>
<td>Ceiling mount</td>
<td>ELPMB36</td>
</tr>
<tr>
<td>Suspension adapter</td>
<td>ELPMBAPL</td>
</tr>
<tr>
<td>False ceiling plate</td>
<td>ELPMBFCP</td>
</tr>
<tr>
<td>Security bracket/cabling for gyro lock mounts</td>
<td>ELPMBSEC</td>
</tr>
<tr>
<td>Adjustable ceiling channel</td>
<td>ELPMBACC</td>
</tr>
<tr>
<td>Kensington® security lock</td>
<td>ELPSL01</td>
</tr>
<tr>
<td>Projection screens:</td>
<td></td>
</tr>
<tr>
<td>50-inch portable screen</td>
<td>ELPSC06</td>
</tr>
<tr>
<td>60-inch portable pop-up screen</td>
<td>ELPSC07</td>
</tr>
<tr>
<td>80-inch portable pop-up screen</td>
<td>ELPSC08</td>
</tr>
<tr>
<td>83.6-inch hanging pull-down screen</td>
<td>ELPSC09</td>
</tr>
<tr>
<td>Macintosh adapter set</td>
<td>ELPAP01</td>
</tr>
<tr>
<td>Component video cable</td>
<td>ELPKC19</td>
</tr>
<tr>
<td>S-Video cable</td>
<td>ELPSV01</td>
</tr>
<tr>
<td>Distribution amplifier</td>
<td>ELPDA01</td>
</tr>
<tr>
<td>High resolution document imager</td>
<td>V12H162020</td>
</tr>
</tbody>
</table>

You can purchase these accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at [www.epsonstore.com](http://www.epsonstore.com) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales).
Welcome
1

Displaying and Adjusting the Image

Whether you’re presenting from a computer or video equipment, you need to follow some basic steps to display your image on the screen.

Follow the guidelines in this chapter for:

■ Positioning the projector
■ Turning the projector on and selecting the image source
■ Troubleshooting display problems
■ Adjusting the image
■ Turning off the projector
Positioning the Projector

If the projector isn’t already installed in the room you’re using, you’ll probably want to place it on a table in front of the screen, as shown. This lets you stand in the front of the room, face the audience, and remain close enough to the equipment to be able to control it. Try to leave as much space as possible between the projector and the screen to get a good-size image.

Use the figure below to help you determine placement. Image size increases with distance, but can vary depending on how you position the zoom ring and whether you’ve adjusted the image with other settings.

Also keep these considerations in mind:

- Place the projector on a sturdy, level surface.
- Make sure there is plenty of space for ventilation around and under the projector. Do not set the projector on top of anything that could block the vents under the projector.
- Make sure the projector is within 10 feet of a grounded electrical outlet or extension cord.
Ideally, you should place the projector directly in front of the center of the screen, facing it toward the screen squarely. The base of the lens should be at about the level of the bottom of the screen.

If you place the projector below screen level, you’ll have to tilt it up by extending the front adjustable foot. This causes the image to become “keystone” shaped, but you can correct the distortion by pressing the Sync buttons on the projector. See page 26 for detailed information about correcting the image shape.

For instructions on installing the projector in a permanent location, such as a theater or conference room, see page 187.

**note**
After positioning the projector, you may want to connect a Kensington MicroSaver® anti-theft device to the lock port on the projector’s left side. You can purchase this from Epson; see “Optional Accessories” on page 13.
Projecting the Image

Make sure your projector and other equipment are set up as described on page 45. Then follow the instructions below to start the projector and display an image.

Turning On the Projector

Turn on any connected computer or video equipment before starting the projector so it can automatically detect and display the image source. If you turn on the projector first, or have multiple pieces of connected equipment, you may have to select the image source manually (see page 20).

Follow these steps to turn on the projector:

1. Remove the lens cap.
2. Plug one end of the power cable into the projector, and the other end into a grounded electrical outlet.
3. Wait until the Power light remains orange.

note
To shut down the projector, see page 29. Shutting down the projector correctly prevents premature lamp failure and possible damage from overheating.

note
If the Direct Power ON feature has been enabled (as described on page 30), the Power light flashes green (instead of orange) when you plug it in. When the light stays green, the projector is ready for use.
4. Press the red \textit{Power} button on top of the projector—or press the \textit{Power} button on the remote control.

(If this is your first time using the remote control, make sure the batteries are installed and the \textit{ON/OFF} switch on the side of the remote is turned on.)

The projector beeps once and the \textit{Power} light flashes green as the projector warms up, then an image begins to appear. When the \textit{Power} light stops flashing and remains green, the projector is ready for use.

5. If you’ve connected a Windows-based computer to the projector, you may see a New Hardware Wizard screen saying your computer has found a plug-and-play monitor; if so, click \textit{Cancel}.

6. If you are prompted to enter a password, see page 127.

\textbf{warning}
Never look into the lens when the lamp is on. This can damage your eyes, and is especially dangerous for children.

\textbf{note}
To conserve electricity and make the lamp last longer, you can enable the \textit{Sleep Mode} function. This feature turns off the lamp and reduces power consumption whenever the projector has not received any signals for 30 minutes. See page 134 for more information.
**Selecting the Image Source**

Selecting the image source lets you switch between images input from different pieces of connected equipment (such as a computer or DVD player).

If you don’t see the image you want, press the **Source Search** button on the remote control or the projector.

You can also select your image using the **Source** buttons either on the projector or the remote control as follows:

- The projector has two **Source** buttons. Use the **Computer/Component** button to switch between EasyMP, and between equipment connected to the **Computer/Component** ports.
  
  Use the **Video/S-Video** button to switch between equipment connected to the **Video** and **S-Video** ports.

- The remote control has five **Source** buttons. Use them to switch between devices connected to the ports identified on each button, or select EasyMP™ to project wirelessly or from a memory card.

You can also press the **Source Search** button on the projector or the remote repeatedly until you see the image you want to project on the screen.

---

**note**

*To focus and adjust the image, see page 24. If a projected image fails to appear, see page 21 for help.*

---

**note**

*You can also preview all sources on one screen to help you select the desired source (see page 35).*
Troubleshooting Display Problems

Follow these guidelines if you’re having trouble displaying an image.

You Can’t Project an Image

If you don’t see the image you are trying to project, try the following:

■ Make sure the cables are connected correctly, as described beginning on page 45.

■ Make sure the Power light is green and not flashing and the lens cap is off.

■ If you’ve connected more than one computer and/or video source, you may need to press one of the Source buttons on the projector’s control panel or the remote control to select the correct source. (Allow a few seconds for the projector to sync up after pressing the button.)

■ If you’re using a PC notebook, press the function key on your keyboard that lets you display on an external monitor. It may be labeled CRT/LCD or have an icon such as 🖥️LCD. You may have to hold down the Fn key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.

The Projector and Notebook Don’t Display the Same Image

If you’re projecting from a notebook, and you can’t see your image on the projection screen and on your computer at the same time, follow these guidelines.

If you’re using a PC notebook:

■ On most systems, there’s a function key that lets you toggle between the LCD screen and the projector, or display on both at the same time. It may be labeled CRT/LCD or have an icon such as 🖥️LCD. You may have to hold down the Fn key while pressing it. Allow a few seconds for the projector to sync up after changing the setting.
- If the function key doesn’t permit you to display simultaneously on both screens, you should check your monitor settings to make sure both the LCD screen and the external monitor port are enabled.

From the Control Panel, open the Display utility. In the Display Properties dialog box, click the Settings tab, then click Advanced. The method for adjusting the settings varies by brand; you may need to click a Monitor tab, then make sure the external Monitor port is set as your primary display and/or enabled. See your computer’s documentation or online help for details.

*If you’re using Macintosh OS X:*

You may need to set up your system to display on the projector screen as well as the LCD screen. Follow these steps:

1. From the Apple menu, select System Preferences, then select Displays.

2. Make sure the VGA Display or Color LCD dialog box is selected.

3. Click the Arrangement (or Arrange) tab.

4. Make sure the Mirror Displays checkbox is selected.
If you’re using OS 8.6 to OS 9.x:
You may need to set up your system to display on the projector screen as well as the LCD screen. Follow these steps:

1. From the Apple menu, select Control Panels, then click Monitors or Monitors and Sound.
2. Click the Arrange icon.

3. Drag one monitor icon on top of the other.

If the Arrange option isn’t available, you may need to select one of the Simulscan resolution settings:

1. Click the Monitor icon.

2. Select a Simulscan resolution as shown. (Allow a few seconds for the projector to sync up after making the selection.)
Adjusting the Image

Once you see your image, you need to make certain adjustments:

- If the image is too high or too low, you can reposition it. See below.
- If you have quick setup enabled on the projector, see page 25.
- To focus or zoom your image, see page 25.
- If the image isn’t square, see page 26.
- If a computer image displays incorrectly, see page 28.

If you need to fine-tune the image and/or sound, see page 117.

Adjusting the Height of Your Image

If the image is too low on the screen, you can use the front adjustable foot to raise it.

1. Stand behind the projector. Press the blue foot release lever up and lift the front of the projector.

2. Once the image is positioned where you want it, release the lever to lock the foot in position.

3. If necessary, you can fine-tune the height or level the image by turning the projector’s rear feet.

Raising the projector causes the image to distort or “keystone,” but you can manually correct the shape as described in the next section.
**Using Quick Setup**

You can use the Quick Setup button on the projector or the remote control to quickly and automatically adjust the projector’s focus, zoom, and shape, as well as the Wall Shot setting. All you need to do is position your projector, then press Quick Setup. (You may need to enable Quick Setup for some of the settings you want to use; see page 135.)

**Focusing and Zooming Your Image**

Your projector automatically focuses the image (unless you have turned this feature off), but you can also use the Focus buttons on the projector or remote to sharpen the image.

Use the Zoom buttons on the projector or remote to reduce or enlarge the image. Press the W button on the projector or the top zoom button on the remote to increase the size, and the T button on the projector or bottom zoom button on the remote to decrease it.

If the image still isn’t large enough, you may need to move the projector farther away from the screen. You can also use the E-Zoom buttons on the remote control to zoom in on a portion of the image. See page 38 for instructions.
**Adjusting the Image Shape**

In most cases, you can maintain a square or rectangular image by placing the projector directly in front of the center of the screen with the base of the lens level with the bottom of the screen.

Even if the projector is slightly tilted (within a range of 40° up or down), the projector has an automatic keystone correction function that detects and corrects vertical keystone distortion.

It takes about one second after projection starts for the image to be corrected. During this time, a vertical keystone correction gauge appears on the screen.

If your image is still distorted, you can correct it using either of these methods:

- If the image has two parallel sides but is wider on one side (top, bottom, left, or right), you can correct it using the Keystone buttons on the projector’s control panel (see page 27) or the projector’s Keystone menu (see page 27).
- If the image has no parallel sides, you can adjust its shape using Quick Corner (see page 36).

You cannot use both keystone correction and Quick Corner at the same time.
Using Keystone Correction

To adjust your image when it is wider on one side, do the following:

- Look at the shapes of the icons on the projector’s four keystone buttons. Press the button whose icon is the opposite of the shape of your screen image. Continue pressing the button until you are satisfied with the shape of the image.

- Or press the Menu button on the remote control, select the Setting menu, and press Enter. From the Setting menu, select Keystone and press Enter, select H/V Keystone and press Enter, then select Horiz./Vert./Height and press Enter. Select V-Keystone (for vertical keystone distortion) or H-Keystone (for horizontal keystone distortion) and press Enter. Use the pointer button on the remote control to adjust the keystone setting as needed.

**note**

The image will be slightly smaller after adjusting. If it’s important to maintain the correct aspect ratio, use the menu system to perform keystone correction, then use the remote’s Resize button to adjust the aspect ratio. See page 123.
Correcting Computer Images

If you’re connected to a computer and the image doesn’t look right, press the Auto button on the remote control. This automatically resets the projector’s tracking, sync, resolution, and position settings.

If vertical bands appear in the projected image and the Auto button doesn’t correct the problem, hold down the Shift button on the projector’s control panel while pressing either the Tracking + or the Tracking - button.

If the image appears fuzzy or flickers and the Auto button doesn’t correct the problem, hold down the Shift button while pressing either the Sync + or Sync - button on the projector.
Shutting Down the Projector

When you’ve finished using the projector, follow the recommended procedure to shut it down. This extends the life of the lamp and protects the projector from possible overheating.

1. Turn off any equipment plugged into the projector.
2. To turn off the projector, press the red Power button on the projector or remote control.

   ![Power button](image)

   You see a confirmation message. (If you don’t want to turn it off, press any other button.)

3. Press the Power button again. The projector lamp is turned off. The Power light may flash orange for about 30 seconds as the projector cools down and then stays orange. The exhaust fan shuts off.

   If you want to turn the projector on again, make sure the Power light is not flashing orange. Then press the Power button.

4. If you extended the adjustable front foot, press up on the blue foot release lever to retract it.

5. Replace the lens cap and unplug the power cord.

6. If you’re using a remote control, set its ON/OFF switch to OFF.
**Using the Direct Power ON Function**

The Direct Power ON function enables faster startup. It’s convenient for ceiling mounted projectors because you can simply flip a switch that is connected to the power outlet for the projector to turn it on and off. For desktop or table-top presentations, just connect the power cord to turn it on.

You can also turn the power on to restart the projector immediately after turning it off.

Follow these steps to enable Direct Power ON:

1. Press the **Menu** button on the remote control and select the **Extended** menu.
2. Choose **Operation** and press **Enter**.
3. Choose **Direct Power ON** and press **Enter**.

4. Highlight **ON** and press **Enter**.
5. Press **Esc** or **Menu** to exit.

With Direct Power ON enabled, when you connect the power cable or turn on the projector, the **Power** light flashes green and then stays green, indicating the projector is ready.
Using the Remote Control

The projector includes a number of tools to enhance your presentation. All of them can be accessed using the remote control, which lets you operate the projector from anywhere in the room—up to 33 feet away.

You can use the remote control to adjust the picture and sound (page 34) or as a pointer to highlight your presentation (page 43). You can also use it to make automatic color corrections that let you project images onto any surface (page 40) or as a wireless mouse when projecting from a computer (page 41).

This chapter covers:

- Turning on and using the remote control
- Controlling the picture and sound
- Projecting images without a screen
- Operating your computer with the remote control
- Highlighting your presentation

note
For information and resources to help you give the most professional presentation, be sure to visit presentersonline.com.
Turning On and Using the Remote Control

The remote control has an ON/OFF switch on its side, as shown. Before using the remote, make sure batteries are installed as described on page 33, then push up on the ON/OFF switch to turn it on.

Turn off the remote control before transporting or storing it; this prevents the batteries from discharging if something presses against one of the buttons.

Here are some additional tips:

- Point the remote control either at the front or back of the projector, or at the screen.

- Stand within 33 feet of the projector. If you want to operate the projector from a greater distance, a remote control cable set is available (see page 13).

- When presenting in a darkened room, press the * light button to make the buttons on the remote light up temporarily.

- Avoid using the remote under bright fluorescent lamps or in direct sunlight, or the projector may not respond properly.
Replacing the Batteries

If the projector stops responding to the remote control, check the following:

■ Make sure the remote control’s ON/OFF switch (shown on page 32) is in the ON position.

■ Press the light button and check to see if the buttons on the remote control light up. (If you’re in a bright room, you may not be able to see them light up.)

If the buttons do not light up, replace the batteries as described below:

1. Turn the remote control over.

2. Press down on the ridges at one end of the battery cover as you slide the cover off.

3. Install two AA batteries, inserting the flat (negative) ends in first.

4. Slide the cover back in place.

caution
When replacing batteries, take the following precautions:

■ Replace the batteries as soon as they run out. If the batteries leak, wipe away battery fluid with a soft cloth. If fluid gets on your hands, wash immediately.

■ Do not expose batteries to heat or flame.

■ Dispose of used batteries according to local regulations.

■ Remove the batteries if you won’t be using the projector for a long period of time.
Controlling the Picture and Sound

You can use the remote control to preview and select your picture sources, temporarily turn off the picture and sound, freeze the action, zoom in on the picture, display a picture-in-picture image, and adjust the volume.

Switching Between Picture Sources

If your projector is connected to more than one computer and/or video source, you can switch between the different sources:

- The easiest way to select your source is to press the Source Search button on the remote control or projector repeatedly until you see the image you want on the screen.

- On the projector’s control panel, there are three Source buttons: Press the Source Search button to automatically search for any image signals from connected devices, press the Computer/Component button to switch between EasyMP and equipment connected to the Computer/Component ports, or press the Video/S-Video button to switch between equipment connected to the Video and S-Video ports.

- On the remote control, there are five Source buttons. Use them to switch between equipment connected to the port identified on each button, or to use EasyMP to project wirelessly or from a memory card.

After you select a source, the screen goes dark for a moment before the image appears.
**Previewing Picture Sources**

You can display a preview image from each connected source to help you select the image source you want.

1. Press **Preview** on the remote control.

You see the currently selected source displayed in the main window, as shown below. All other sources (including the currently selected source) are displayed in smaller preview windows on the right side and at the bottom. If no equipment is connected to a port, there is no incoming signal, or the signal is out of range, the preview window for that source appears blank.

2. Press one of the **Source** buttons on the remote control to switch to the desired source. Press **Enter** to change the source and exit the screen or press **Esc** to exit the preview screen without switching sources.

**note**
Movies are displayed as still images on the preview screen.

**note**
A red highlight surrounds the preview window for the currently selected source. Use the ◼ pointer button on the remote control to highlight a different source and press **Enter** to display it.
Adjusting the Image Shape

Even if your projected image has no parallel sides, you can even up the sides using Quick Corner. Follow these steps:

1. Press the **Menu** button on the remote control (or on the projector’s control panel).

2. Select the **Setting** menu and press **Enter**.

3. From the Setting menu, select **Keystone** and press **Enter**.

4. Select **Quick Corner** and press **Enter**.

   You see this screen:

   5. Press the **Enter** button to select the corner you want to adjust.

   6. Use the ◆ pointer button on the remote control (or the arrow buttons on the projector) to adjust the shape.

   7. Repeat steps 5 and 6 as needed to adjust any remaining corners.

   8. When done, press the Esc button on the remote control or projector’s control panel to exit the menu system.

If **Quick Corner** remains selected in the Keystone menu, the Quick Corner screen appears whenever you press the projector’s keystone buttons. You can then follow steps 5 through 8 above to correct the shape of your image or press Esc to exit Quick Corner.

**note**

If you are already using Keystone settings, you see a warning message. To disable keystone settings and use Quick Corner instead, press Enter; to keep your settings, press Esc.

If you are not satisfied with the corrections made, press the Esc button for one second to reset the screen to its original shape.
**Turning Off the Picture and Sound**

You can use the **A/V Mute** button on the remote control to turn off the image and sound and darken your screen. This feature is useful if you want to temporarily redirect your audience’s attention without the distraction of a bright screen.

- To turn off the picture, press the **A/V Mute** button. The screen goes dark.
- To turn the image back on, press the button again.

You can also have an image, such as a company logo, display on the screen whenever you press the **A/V Mute** button (see page 130).

**Stopping Action**

You can use the remote control to stop the action in your video or computer image.

- To stop the action and keep the current image on the screen, press the **Freeze** button. The sound continues.
- To restart it, press the **Freeze** button again.

---

**note**

If you’ve connected a computer to one of the projector’s Computer ports and an external monitor to the projector’s Monitor Out port, the monitor will continue displaying.

---

This function pauses the image, but not the sound. Also, because the source continues to transmit signals, you won’t resume the action from the point you stopped it.
**Zooming Part of Your Image**

You can zoom in on a portion of the image using the E-Zoom buttons on the remote control.

1. Press the E-Zoom button on the remote control.
   
   You see a crosshair indicating the center of the zoom-in area.

2. Use the pointer button to position the crosshair.

3. Continue pressing the E-Zoom button to enlarge the selected area up to 4 times.

4. While the image is enlarged, you can:
   - Use the pointer button to move around the screen.
   - Press the E-Zoom button to zoom out.

5. When done, press the ESC button to return the image to its original size.

**Displaying a Picture-in-Picture Video**

If you’re displaying an image from equipment connected to the Computer port(s), you can open up a smaller picture-in-picture window on the screen. This window can display video from equipment connected to either the Video or S-Video port.

**Setting Up the Picture-in-Picture Image**

Before starting, make sure the computer or video equipment for your main image is connected to the Computer port(s), and the video equipment for the picture-in-picture window is connected to the Video or S-Video port. Then select the corresponding video setting:

1. Press the Menu button on the remote control and enter the Setting menu.

2. Highlight P in P Options and press Enter, then use the pointer button to select Subscreen Image and press Enter.

3. Press Menu to exit the menu system.

---

**note**

The Picture-in-Picture function does not work for RGB video images.
**Displaying the Picture-in-Picture Image**

Make sure your main image source is displayed, then follow these steps to display and use the picture-in-picture window:

1. Press the PinP button on the remote control.
2. Use the pointer button to reposition the video window.
3. Once the window is the way you want it, press the Enter button; your video continues playing on the screen.
4. When you’re finished using picture-in-picture, press the PinP or pointer button again. The window disappears.

**Controlling the Volume**

To change the volume, press the quieter or louder side of the Volume button.

If necessary, you can adjust the tone using the projector’s menu system. See page 126.
Projecting Images Without a Screen

Even if you don’t have a screen, you can project images onto surfaces like blackboards and colored walls without loss of image color. Your projector has a sensor that measures the conditions of the projection surface and automatically adjusts the colors and shading of your image. For example, if you’re projecting onto a surface near a window, your image appears clear and bright rather than faint.

Making Initial Color Corrections

Press the Wall Shot button on either the remote control or the projector’s control panel while projecting an image.

Wall Shot’s status appears in the upper right corner of your screen. Then you see a sequence of colors flash for a couple of seconds while the sensor measures the conditions of the projection surface and adjusts the image.

The projector stores the correction values obtained by the last Wall Shot measurements. This is useful if you’re projecting against the same surface and under the same conditions. To retrieve these corrections, repeatedly press the Wall Shot button until you see Wall Shot Memory Call. This setting applies the stored Wall Shot values.
Adjusting Color Corrections for a New Surface

Adjust the correction values if you’re projecting on a new surface or in a new location.

1. Press the Wall Shot button on the remote control or projector while you’re projecting an image. Make sure Wall Shot is on.

2. Press the Wall Shot button a couple of times until you see Wall Shot Readjustment as the status in the upper right corner of your screen.

   You see a sequence of colors flash for about five seconds as the projector adjusts the color correction values for the new projection surface.

Operating Your Computer with the Remote Control

If you’ve connected a computer to the projector with a USB cable, as described on page 49, you can use the remote control in place of your computer’s mouse. This gives you more flexibility when delivering slideshow-style presentations, since you won’t have to stand next to the computer to change slides.

- Use the Page buttons to move through a slideshow.
- Use the \( \circ \) pointer button to move the cursor on the screen.
- Press the \textbf{Enter} button once to left-click, or press it twice to double-click. Press the \textbf{Esc} button to right-click.
- To drag-and-drop, hold down the \textbf{Enter} button for about one second until it lights. Then use the \( \circ \) pointer button to drag the object. When it’s where you want it, press \textbf{Enter} to release it.
**Highlighting Your Presentation**

You can display a pointer to call out something on the screen, or draw straight or curved lines to emphasize particular points. There are three pointer tools you can choose from and each one can be customized for a different look.

**Using the Pointer Tool**

1. To activate the pointer tool, press the **Pointer** button on the remote control. A pointer appears on the screen.

   ![Pointer](image)

   If you prefer to use a different style of pointer, see page 44 to choose from three preset options.

2. Use the **pointer** button on the remote control to position the pointer on the screen.

3. When done using the pointer, press **Esc** to clear the screen.
Customizing the Pointer Tools

You can customize the shape and size of each of the three pointer tools, and set how fast you can move the pointer across the screen.

1. Press the Menu button on the remote control, highlight the Setting menu, highlight Pointer, and press Enter.

   You can select one of the following pointer shapes:

   ![Pointer Shapes]


3. To change the size of the pointer, highlight Pointer Zoom and press Enter.

4. Choose 100% or 200% and press Enter.

5. Highlight Return and press Enter.

6. To change the Pointer Speed setting, highlight Pointer Speed and press Enter.

7. Highlight High Speed, Medium Speed, or Low Speed and press Enter.


9. Press Menu to exit from the menu system.
Connecting to Computers, Cameras, and Other Equipment

This chapter tells you how to connect the projector to a notebook or desktop computer, and/or to video equipment, such as a VCR or DVD player. You can also connect the projector to a digital camera, video camera, external speakers, and/or an external monitor.

Follow the instructions in this chapter on:

- Connecting to a computer
- Connecting an external monitor
- Connecting video equipment
- Connecting to a digital camera or other USB device
- Playing sound through the projector
Connecting to a Computer

You can connect the PowerLite projector to any computer that has a standard video output (monitor) port, including desktop models, PC notebook and notebook computers, Macintosh PowerBooks and iBooks, and hand-held devices. You can connect up to two computers at the same time. To connect to the Computer/Component ports (standard VGA cable connection), see page 47. After connecting to the computer, you may also want to:

- connect a USB cable so you can use the remote control as a mouse; see page 49
- connect a monitor to the projector so you can view your presentation close-up as well as on-screen (not necessary if you’re using a notebook); see page 50
- connect an audio cable to play computer audio; see page 57

**note**
If you connect a Windows-based computer to the projector, you may see a New Hardware Wizard saying your computer has found a plug-and-play monitor; if so, click Cancel.

**note**
For newer PowerBooks with DVI connectors, see your computer’s documentation to see how to use a DVI to VGA adapter (usually included with the computer) to connect to the VGA Computer port.

If you’re using an older Macintosh and you can’t connect the cable to your computer, you may need to use the Macintosh desktop adapter, as shown on page 48 (available from Epson; see page 13).
**Connecting to the Computer Ports**

You can connect to either Computer/Component port using the VGA computer cable that came with the projector (the monitor port on your computer must be a mini D-sub 15-pin port).

1. If you're using the VGA computer cable, connect one end to one of the projector’s Computer/Component ports, and the other end to your computer's monitor port. Then go to step 4.

2. You can connect an optional stereo mini-jack audio cable to play sound through the projector (see page 57), an external monitor (see page 50), or a USB cable to use the remote control as a mouse (see page 49).

3. When you've finished making any connections, see page 18 for instructions on turning on the projector and adjusting the image.

---

**caution**

Don’t try to force a connector to fit a port with a different shape or number of pins. You may damage the port or connector.
Using the Macintosh Desktop Adapter

If you have an older desktop Macintosh or PowerBook, the VGA cable may not fit when you try to connect it. If so, you’ll need to use the Macintosh desktop adapter to connect the VGA cable to your computer. This is available from Epson (see page 13).

1. To use the adapter, remove its cover as shown and set its DIP switches according to the resolution you want to use, such as 16-inch mode. See your Macintosh documentation for instructions.

2. Replace the cover and connect the adapter to the VGA cable. Then plug the cable (with the adapter) into the video port on your Macintosh.

3. Tighten the screws on the connectors.
Connecting the Cable for Remote Mouse Control

If you’ve connected a computer as described in this chapter, you can use the projector’s remote control as a wireless mouse. This lets you control your computer and click through slideshow-style presentations, such as PowerPoint, from up to 33 feet away.

The wireless mouse function is supported on systems with a USB port running Windows XP, 98, Me, or 2000, or Macintosh OS X 10.2.x to 10.3.x or OS 8.6 to OS 9.x.

1. Locate the USB cable that came with your projector.
2. Connect the square end of the cable to the projector’s USB port.
3. Connect the flat end of the cable to any available USB port on your notebook or desktop computer.
4. If necessary, configure your computer to work with an external USB mouse. See your computer documentation for details.

note
The remote mouse control function may not operate correctly on systems that have been upgraded from an earlier version of Windows.

note
For details on using the remote control in place of your computer’s mouse, see page 41.

Use to move cursor

Left-click  Right-click
Connecting an External Monitor

If you want to monitor your presentation close-up (on a monitor placed beside the projector) as well as on the screen, you can connect an external monitor.

To attach an external monitor, connect it to the projector’s Monitor Out port, as shown:

Follow these guidelines to view images on the monitor:

- The monitor displays the currently selected computer source. Press the Preview button on the remote control if you want to display all the active sources at the same time (see page 35).
- You can also view images on the monitor while the projector is in Standby mode, if you’ve set Network ON in the Extended menu (see page 134).
Connecting to Video Equipment

You can connect up to four video sources to the projector at the same time. Before starting, look at your video equipment to determine its available video output connections:

- If your video player has a yellow RCA-style video output connector, see “Connecting a Composite Video Source” on page 52.
- If your video player has an S-Video connector, see “Connecting an S-Video Source” on page 53.
- If your video player has a component video port (three connectors labeled either Y/Cb/Cr or Y/Pb/Pr), see “Connecting a Component Video Source” on page 54.
- If your video player has an RGB video port (either a single connector for a VGA-style monitor cable or three connectors labeled R/G/B), see “Connecting an RGB Video Source” on page 55.

After connecting video cables, you may also want to:

- Connect a monitor to the projector so you can view your presentation close-up as well as on-screen; see page 50.
- Connect an audio cable to play sound through the projector; see page 57.
Connecting a Composite Video Source

1. Locate the RCA-style video cable provided with the projector.

2. Connect the cable to the yellow video output connector on your player and the yellow Video connector on the projector:

3. If you want to play sound through the projector, see page 57 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see page 18 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.
**Connecting an S-Video Source**

1. Locate an S-Video cable (one is usually provided with your video equipment or you can purchase one from Epson; see page 12).

2. Connect the cable to the S-Video connector on your player and the S-Video connector on the projector:

3. If you want to play sound through the projector, see page 57 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see page 18 or the Quick Setup sheet for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.
Connecting a Component Video Source

1. Locate a component-to-VGA video cable.

2. Connect the cable to your player and one of the Computer/Component connectors on the projector.

3. If you want to play sound through the projector, see page 57 for instructions on connecting an audio cable.

4. If you don’t need to make any other connections, see page 18 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.

Note
Be sure your video player is not an RGB video source. If you select the wrong source, image quality may suffer. Check your video player’s documentation.
Connecting an RGB Video Source

1. Locate the VGA computer cable provided with the projector.
2. Connect the cable to the video port on your player and one of the Computer/Component ports on the projector.
3. If you want to play sound through the projector, see page 57 for instructions on connecting an audio cable.
4. If you don’t need to make any other connections, see page 18 for instructions on turning on the projector and adjusting the image. Once the projector is turned on, select the image source: press the Search button on the remote control or press the Source Search button on the projector’s control panel repeatedly until the image appears.

**note**
Be sure your video player is not a component video source. If you select the wrong source, image quality may suffer. Check your video player’s documentation.
Connecting to a Digital Camera or Other Device

You can connect your digital camera, USB flash memory drive, USB hard drive, or digital photo storage device, such as the Epson P-1000, to the projector using the USB cable specified for your device. Then you can use your camera’s slideshow function or the projector’s EasyMP CardPlayer feature (see page 99) to present images.

1. Make sure there is no card inserted in the projector’s card slot.
2. Connect the flat end of the USB cable to the USB Type A port on the projector, as shown.

3. Connect the square end of the cable to your camera or other device.

Removing the USB Cable

If you’re using CardPlayer to project your images, close the program before you remove the USB cable from the projector.

1. Position the cursor over the EJECT button in the upper right corner of the CardPlayer screen.
2. Press the Enter button on the remote control to close CardPlayer.
3. Disconnect the USB cable.

Note: Use a cable less than 10 feet long and connect the camera directly to the projector. Your projector may not function correctly if you use a longer cable or connect your camera to a USB hub.
**Playing Sound Through the Projector**

You can play sound through the projector’s speaker system or attach an external speaker system. Attaching speakers to the projector instead of directly to the audio source lets you use the projector’s remote control to adjust the sound.

**Connecting Audio Equipment to the Projector**

To play sound through the projector, follow these steps:

1. Locate the appropriate commercially available audio cable. Which cable you use depends on how your equipment is connected:
   - If you have a computer connected to a **Computer/Component** port, use a stereo mini-jack cable.
   - If you have video equipment connected to the **Video** or **S-Video** port, use an RCA-style audio cable.

2. Connect the audio cable to the jack corresponding to the connected video source.

3. Connect the other end of the cable to the audio output connector on your computer or video equipment.
Connecting External Speakers

To connect speakers to the projector, follow these steps:

1. Locate the appropriate cable to connect your speakers.

   Depending on your speakers you may be able to use a commercially available audio cable with a stereo mini-jack connector on one end and pin jacks on the other end. For some speakers, you may have to purchase a special cable or use an adapter.

2. Connect the stereo mini-jack end of the audio cable to the Audio Out port on the projector.

3. Connect the other end(s) of the cable to your speakers.

The projector’s internal speaker system is disabled while sound is output to external speakers.
Presenting Through a Wireless Network

This chapter tells you how to send pictures to the projector through a wireless network. Using EMP NS Connection, you can project images shown on your computer screen—including text and graphics—directly to your audience. Because images are displayed in real-time, any changes you make on your PC or notebook are automatically mirrored on the screen.

You’ll find instructions in this chapter on:

■ Starting EasyMP
■ Connecting to the projector in Ad Hoc (computer-to-computer) mode or Access Point (infrastructure) mode
■ Using wireless security options
■ Projecting wirelessly
■ Using projector groups
■ Removing the wireless 802.11g card

Before starting, make sure you’ve installed EMP NS Connection as described on page 183 for each computer you want to connect to the projector. Then follow the steps in this chapter to start EasyMP, configure your projector and computer, and run EMP NS Connection.
Presenting Through a Wireless Network

Starting EasyMP

Before connecting to the projector, you have to switch it to EasyMP mode. Follow these steps:

1. Turn on the remote control, as described on page 32. Point it at the projector and press the Power button.

2. Press the EasyMP button on the remote control to select EasyMP as the source.

3. Insert the Epson 802.11g card in the card slot with the label facing upward.

---

**note**

Only the Epson 802.11g card is guaranteed to work. Other brands may not be compatible.

**caution**

Be careful to insert the card correctly and never force the card in; doing so may damage it. The black end of the card protrudes from the slot when the card is fully inserted.

Always remove the card before transporting the projector. See page 93 for instructions.
Once the card is inserted, you see one of these screens, depending on the currently selected mode:

**note**
If you see a message asking you to insert a LAN or memory card, check to make sure your 802.11g card is properly inserted.

4. If you’ve already set up your computer and projector for the mode you want to use—Ad Hoc mode (also called computer-to-computer mode) or Access Point mode (also called infrastructure mode)—skip to “Projecting Wirelessly” on page 83. Otherwise, continue with the next section.
Configuring the Connection

You can use NS Connection to connect to the projector and send images wirelessly in two modes: Ad Hoc mode or Access Point mode.

- **Ad Hoc mode** (computer-to-computer mode) lets you connect just one computer to the projector at a time; it’s easy to set up, and the only equipment you need is a computer with a wireless (802.11g or 802.11b) network card or adapter, or a Macintosh with an AirPort<sup>®</sup> or AirPort Extreme card.

- **Access Point mode** (infrastructure mode) lets multiple computers access the projector at the same time and easily trade off control over the projector. To use Access Point mode, you need a wireless (802.11g or 802.11b) access point or an AirPort Extreme (or AirPort) base station, and one or more computers with wireless network cards or adapters.

Follow the instructions below for the mode you want to use.

**Using Ad Hoc Mode**

To use Ad Hoc (computer-to-computer) mode, adjust your projector and wireless card or adapter settings as described in this section.

**Configuring the Projector**

1. Switch the projector to EasyMP mode and insert the Epson 802.11g card (see page 60). You see this screen:
2. To select Config, press the Enter button on the remote control. You see the following screen:

![Easy connect mode](image)

Make sure Easy connect mode is selected, as shown above. If not, use the pointer button on the remote control to highlight the checkbox next to Easy connect mode, then press Enter to select it.

3. Make sure the projector has a unique name, so you can identify it when connecting to it from your computer.

![Projector name](image)

If you need to rename it, highlight the Projector name text box then press Enter. The outline of the text box turns yellow to indicate you are in input mode. Press the pointer button up to select individual letters in alphabetical order, or down to select letters in reverse order; then press the pointer button to the right to move to the next character position. When you’re done typing the new name, press Enter.

**note**

If you want to enter a blank space, use the space character that comes before the capital letter A.

If you want to enter numbers, press the Num button on the remote control. The button lights up to indicate that the numeric keypad mode is active. Press the Num button again to exit numeric keypad mode.
Presenting Through a Wireless Network

4. If your network card supports an SSID or ESSID name (see page 66), highlight the ESSID text box, press Enter, and enter a name. When you’re done, press Enter. Note that the ESSID is case-sensitive (if you enter the name in uppercase on the projector, you must type it the same way on the computer connecting to the projector).

5. If you want to create a password for remote access to the projector, highlight the Password for WEB control checkbox, press Enter, and enter a password of up to 8 alphanumeric characters. When you’re done, press Enter.

6. If you want to set up a security keyword so that only people who are in the same room as the projector can access it, turn Projector keyword on. Then when you want to connect to the projector, it displays a randomized four-digit number or “keyword” on the screen. When prompted by NS Connection, you can enter the keyword on your computer to connect (see page 86).

7. When you’re done making these settings, highlight the OK button at the top of the screen (you can either press the Esc button on the remote control or use the pointer button to highlight it), then press Enter. Highlight the OK button again and press Enter to return to the main EasyMP Network Screen.

Now you’re ready to set up your computer for wireless projecting. Go to “Configuring the Network Settings for Windows” below, or “Setting Up Your Macintosh for Ad Hoc Mode” on page 67.

**Configuring the Network Settings for Windows**

Before connecting to the projector, you need to make sure the settings for your notebook’s or PC’s network card match the settings you entered for the projector.

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon.

---

**note**

The projector keyword changes each time you turn the projector off and then on again, or remove and reinsert the 802.11g card. Check the keyword on the EasyMP Network screen whenever you start EasyMP and enter that keyword on your computer. You can’t connect using a previous keyword.

It is recommended that the keyword setting is changed periodically.

**note**

On some Windows systems, you can right-click My Network Places or Network Neighborhood on the desktop and select Properties.

Settings may vary, depending on your wireless network adapter. See the documentation for your adapter for more information.

---
You see a screen similar to this:

2. Right-click the **Wireless Network Connection** icon and select **Properties**. You see a screen similar to this:

3. Click the **Configure** button.
4. Click the Advanced tab. You see a screen similar to this:

![Advanced tab screen](image)

5. Check your wireless card’s or adapter’s device settings. (Depending on the type of card or adapter you’re using, some of the settings may be different than those listed here.)
   - Set the Network Type to **802.11 Ad Hoc**.
   - Set the SSID to match the name you assigned to the projector’s ESSID.
   - Make sure Encryption is **Disabled**.

6. Click the General tab and make sure that your wireless card or adapter is enabled.

7. When you’re done, click **OK** to close the Properties dialog box.

Now you’re ready to connect to the projector. See “Projecting Wirelessly” on page 83.
Setting Up Your Macintosh for Ad Hoc Mode

Your AirPort software is automatically configured to allow your Macintosh to detect both computer-to-computer (Ad Hoc) and Access Point networks.

Typically, you only need to select your projector’s ESSID from the AirPort status menu on the Macintosh menu bar. If you’re having problems detecting the projector, follow these steps:

1. From the Apple pull-down menu, select System Preferences.
2. Double-click the Network icon. You see the Network settings window.
3. Make sure Location is set to Automatic.
4. Select Network Port Configurations in the Show pull-down menu.
5. Under Port Configurations, select AirPort.
6. Click Apply Now. Then close the window.

Note: If you don’t need the other network port configurations, disable them by deselectiong their checkboxes. If more than one network port is enabled, the projector software warns you to turn off AirPort when you first connect the projector. Disregard this message.
7. Click the AirPort icon on the menu bar at the top of the Macintosh desktop. You see the AirPort status menu:

![AirPort status menu]

Write: Choose the ESSID you assigned to the projector

8. Check to make sure AirPort is turned on.

9. Select your projector’s ESSID.

Using Access Point Mode

To use Access Point (infrastructure) mode, first adjust your projector and wireless access point or AirPort base station settings as described in this section.

Configuring the Projector

1. Switch the projector to EasyMP and insert the Epson 802.11g card (see page 60). You see this screen:

![EasyMP screen]

2. To select Config, press the Enter button on the remote control.

3. Highlight Basic under Wireless LAN and press Enter.
You see the following screen:

Make sure **Access point mode** is selected, as shown above. If not, use the 📢 pointer button on the remote control to highlight the checkbox next to **Access point mode**, then press **Enter** to select it.

4. Make sure the projector has a unique name so you can identify it when connecting to it from your computer.

If you need to rename it, highlight the Projector Name text box and press **Enter**. The text box turns yellow to indicate you are in input mode. Press the 📢 pointer button up to select individual letters in alphabetical order, or down to select letters in reverse order; then press the 📢 pointer button to the right to move to the next character position. When you’re done typing the new name, press **Enter**.

---

**note**

If you want to enter a blank space, use the space character that comes before the capital letter A.

If you want to enter numbers, press the **Num** button on the remote control. The button lights up to indicate that the numeric keypad mode is active. Press the **Num** button again to exit numeric keypad mode.
5. To enable your computer to find the projector on the network, you need to enter an ESSID, which is the SSID name of your access point or the name of your AirPort network. (The name of your AirPort network may be different from that of your AirPort base station; select your base station in the AirPort Admin utility and click Configure to check the name of your network.) Highlight the ESSID text box, press Enter, and enter a name. When you’re done, press Enter. Note that the ESSID is case-sensitive (if you enter the name in uppercase on the projector, you must type it the same way on the computer connecting to the projector).

6. If you want to create a password for remote access to the projector, highlight the Password for WEB control text box and press Enter, and enter a password of up to 8 alphanumeric characters. When you’re done, press Enter.

7. If you want to set up a security keyword so that only people who are in the same room as the projector can access it, turn Projector keyword on. Then when you want to connect to the projector, it displays a randomized four-digit number or “keyword” on the screen. When prompted by NS Connection, you can enter the keyword on your computer to connect (see page 86).

8. If your access point assigns IP addresses automatically, turn on DHCP. Otherwise, turn off DHCP and enter the following information manually:

   - **IP address**: Type in the IP address you want to assign to the projector. It must be formatted like other addresses on the network; the first two segments (XXX.XXX) should match the first two segments of the IP address for your access point or AirPort base station. The last segment should be unique.
   - **Subnet mask**: For example: 255.255.255.000, but this depends on how your network is set up.
   - **Gateway address**: Enter the IP address that was assigned to the access point or AirPort base station when it was set up.

---

**note**
The projector keyword changes each time you turn the projector off and then on again, or remove and reinset the 802.11g card. Check the keyword on the EasyMP Network screen whenever you start EasyMP, and enter that keyword on your computer. You can’t connect using a previous keyword.

**note**
For specific details about your network, please consult your network administrator.

If you don’t know your gateway or access point address, see page 76. If you’re using AirPort, start the AirPort Admin utility, select your base station and click Configure. Then click the Network tab to see your base station’s IP address.
9. If you want to monitor the projector using HP OpenView,™ you’ll need to enter at least one trap IP address. See page 139 for details on monitoring the projector.

10. When you’re done making these settings, highlight the OK button at the top of the screen (you can either use the button on the remote control or press Esc to highlight it), then press Enter. Highlight the OK button again and press Enter to return to the main EasyMP Network Screen.

Now you’re ready to set up your computer for wireless projecting. Go to “Configuring the Network Settings for Windows” below, or go to “Setting Up Your Macintosh for Access Point Mode” on page 77. If you need to use WEP, WPA, or LEAP security options, see page 79 to set up the option that your network uses on the projector.

**Configuring the Network Settings for Windows**

Before connecting to the projector, you need to make sure the settings for your computer’s wireless card or adapter match the settings you entered for the projector.

1. Access your wireless network Properties window. For example, in Windows XP you would click Start > Control Panel > Network and Internet Connections. Then click the Network Connections icon.
You see a screen similar to this:

![Network Connections Window]

2. Right-click the Wireless Network Connection icon and select Properties. You see a screen similar to this:

![Wireless Network Connection Properties]

3. Click the Configure button.
4. Click the **Advanced** tab. You see a screen like this:

   ![Wireless Network Settings](image)

5. Check your wireless card's or adapter's device settings. (Depending on the type of card or adapter you’re using, some of the settings may be different than those listed here.)

   - Set the Network Type to **Infrastructure**.
   - Set the SSID to match the name assigned to the access point (which should also be the projector's ESSID).
   - Make sure Encryption is **Disabled** if you have not set up encryption on the projector.

6. Click the **General** tab and make sure that your wireless card or adapter is enabled.

7. When you’re done, click **OK** to close the wireless properties dialog box.
8. Right-click the Wireless Network Connection icon again and select Properties. You see this screen:

![Wireless Network Connection Properties](image)

9. Select Internet Protocol and click the Properties button. You see this screen:

![Internet Protocol (TCP/IP) Properties](image)
10. If your access point uses DHCP, select **Obtain an IP address automatically**. Otherwise select **Use the following IP address** and enter the required information:

- **IP address**: Type in the IP address you want to assign to the computer. It must be formatted like other addresses on the network; the first two segments (XXX.XXX) should match the first two segments of the access point’s IP address and the last segment must be unique.

- **Subnet mask**: For example: 255.255.255.000, but this depends on how your network is set up.

- **Default gateway**: Enter the IP address that was assigned to the access point when it was set up.

11. When you’re done, click **OK**.

12. Click the **Wireless Networks** tab.

   (If you don’t see this tab, you may need to enable your wireless card or adapter by clicking **Configure** to access the device settings; then follow any instructions on the screen to enable the device.)

You see a screen like this:

![Wireless Network Connection Properties](image)

---

**note**

For specific details about your network, please consult your network administrator.

**note**

If you don’t know your gateway or access point address, see page 76.
13. Verify that you’ve enabled your computer’s connection to the access point. It should be listed with the small 🗺 icon next to it, indicating a connection.

If it’s not listed, click **Configure** and type the name of your access point.

14. When you’re done making settings, click **OK** to close the dialog box.

Now you’re ready to connect to the projector. See “Projecting Wirelessly” on page 83.

---

**Checking the Gateway IP Address on Windows**

If you’re entering IP addresses manually and need to find out the gateway IP address (the IP address of your access point), make sure the wireless connection to the access point is currently active, as described in the previous section. Then follow these steps:

1. Access your wireless network Properties window. For example, in Windows XP you would click **Start > Control Panel > Network and Internet Connections**. Then click the **Network Connections** icon. You see a screen similar to this:

   ![Network Connections](image)

   Right-click and select **Status**

---

**note**

*If you cannot identify the gateway address using this Windows utility, use the administrator’s utility software that came with your access point.*
2. Right-click the Wireless Network Connection icon and select Status.

3. Click the Support tab. The gateway’s IP address is listed as shown:

   ![Gateway address](image)

**Setting Up Your Macintosh for Access Point Mode**

Your AirPort software is automatically configured to allow your Macintosh to detect Access Point networks.

Typically, you only need to select your AirPort network name from the AirPort status menu on the Macintosh menu bar. If you’re having problems connecting to the projector, follow these steps:

1. From the Apple pull-down menu, select System Preferences.
2. Click the Network icon. You see the Network settings window.
3. Make sure Location is set to Automatic.

4. Select **Network Port Configurations** in the Show pull-down menu.

5. Under Port Configurations, select **AirPort**.

6. Click **Apply Now**. Then close the window.

7. Start the AirPort Admin utility. Select your base station, then click **Configure**.

8. On the AirPort tab, make sure your AirPort network name matches your projector’s ESSID. If not, enter the projector’s ESSID in the AirPort Network text box and click **Update**.

9. If you turned DHCP on in your projector’s advanced menu, click the Network tab and make sure the **Distribute IP addresses** checkbox is selected. If you need to select it, click **Update**.
10. Click the AirPort icon on the menu bar at the top of the Macintosh desktop. You see the AirPort status menu:

![AirPort status menu]

11. Check to make sure AirPort is turned on.

12. Select the name of your AirPort network.

**Using Wireless Security Options**

You can use the following security options when connecting to the projector wirelessly: WEP encryption, WPA security, or LEAP authentication. To set these security features up on your wireless network, see your documentation or get help from your network administrator. See the following sections to enable the security option on your projector:

- “Adding WEP Encryption” on page 80
- “Adding WPA Security” on page 81
- “Adding LEAP Authentication” on page 82
**Adding WEP Encryption**

When you click the Security button on the Network screen, you see this screen:

1. Highlight WEP and press Enter.
2. For the WEP encryption setting, highlight 128Bit or 64Bit and press Enter.
3. For Format, highlight HEX to enable hexadecimal input, then press Enter.
4. If you chose 64Bit, highlight Key ID 0, 1, 2, or 3.
5. Highlight the Encryption key text box and press Enter. The box turns yellow to indicate you are in input mode. Press the pointer button up to select individual letters in alphabetical order, or down to select letters in reverse order; then press the pointer button to the right to move to the next character position. When done typing your encryption key, press Enter.

Check with your network administrator for directions on entering a key for your network, and follow these general guidelines:

- For 128 bit WEP encryption with hexadecimal input, enter 26 characters, from 0 to 9 and from A to F.

---

**note**

Text input for WEP encryption varies with different access points; check with your network administrator. Try ASCII first. If that doesn’t work, try Text2 and then Text3.

If you want to enter a blank space, use the space character that comes before the capital letter A.

If you want to enter numbers, press the Num button on the remote control. The button lights up to indicate that the numeric keypad mode is active. Press the Num button again to exit numeric keypad mode.
For 64 bit WEP encryption with hexadecimal input, enter 10 characters, from 0 to 9 and from A to F.

For 128 bit WEP encryption with ASCII or text input, enter 13 alphanumeric characters.

For 64 bit WEP encryption with ASCII or text input, enter 5 alphanumeric characters.

6. When you’re done making settings, highlight the OK button at the top of the screen and press Enter.

Adding WPA Security

When you click the Security button on the Network screen, you see this screen:

1. Highlight WPA and press Enter.

2. Highlight the PSK (pre-shared key) text box and press Enter. The text box turns yellow to indicate you are in input mode. Press the pointer button up to select individual letters in alphabetical order, or down to select letters in reverse order; then press the pointer button to the right to move to the next character position. When done typing the key, press Enter.

3. When you’re done making settings, highlight the OK button at the top of the screen and press Enter.

**note**

WPA is available on the Macintosh only if the wireless LAN on your Mac supports WPA authentication.

**note**

If you want to enter a blank space, use the space character that comes before the capital letter A.

If you want to enter numbers, press the Num button on the remote control. The button lights up to indicate that the numeric keypad mode is active. Press the Num button again to exit numeric keypad mode.
Adding LEAP Authentication

When you click the Security button on the Network screen, you see this screen:

1. Highlight LEAP, then press Enter.

2. Enter the user name and password that match the settings on your authentication server:

   - Highlight the User name text box and press Enter. The box turns yellow to indicate you are in input mode. Press the ▼ pointer button up to select individual letters in alphabetical order, or down to select letters in reverse order; then press the ▼ pointer button to the right to move to the next character position. When done typing the user name, press Enter.

   - Highlight the Password text box and press Enter. The box turns yellow to indicate you are in input mode. Press the ▼ pointer button up to select individual letters in alphabetical order, or down to select letters in reverse order; then press the ▼ pointer button to the right to move to the next character position. When done typing the password, press Enter.

3. When you’re done making settings, highlight the OK button at the top of the screen and press Enter.
Projecting Wirelessly

Once you’ve started EasyMP and set up your projector and computer in either Ad Hoc mode or Access Point mode, follow these steps to start NS Connection and project wirelessly.

1. Make sure you’ve installed your 802.11g wireless card in your projector (see page 60).

2. **Windows:** Select EMP NS Connection from the Start menu.

   **Macintosh OS X:** Double-click the EMP NS Connection icon in your Applications folder.

3. The first time you start NS Connection, you may see a dialog box asking you to select your network. Select the IP address for your computer’s network card and click OK.

   ![Switch network dialog box](image)

   **note**

   If you don’t see your network adapter’s IP address, allow a minute for it to appear. If your access point or AirPort base station uses DHCP (Distribute IP addresses setting is enabled for AirPort), sometimes it takes a minute for the server to pick up the IP address.

   Once you’ve selected the IP address for your network adapter, you won’t see the Switch network dialog box when you start NS Connection. If you want to change to a different network adapter, click Extension on the EMP NS Connection dialog box, then click Switch LAN on the extension dialog box.
You see the screen below. (If you have previously started NS Connection, this is the first screen you see.)

If the connection is working properly, you see your projector listed. If you have additional Epson projectors on the network, they are also listed, along with their status.

The color of the status icon next to each projector’s name indicates its status:

- Gray: the projector is not connected
- Orange: the projector is connected to another computer
- Green: the projector is connected to your computer

If you don’t see your projector, check the following:

- Make sure your wireless signal is strong enough to establish a connection. If you have a Macintosh, check the AirPort icon on the Macintosh menu bar. For Windows, see the documentation for your access point or computer network card.
- Make sure you’re trying to connect to the right network. In Windows, verify that you’ve enabled your computer’s connection to the access point or that your wireless card or adapter is enabled, and that its SSID matches the projector’s ESSID. In Macintosh, check the AirPort status menu (click...
the AirPort icon on your menu bar) to make sure AirPort is turned on and the projector’s ESSID or your AirPort network is selected.

- Make sure you aren’t projecting one of the EasyMP configuration screens. (You should see a message that the projector is ready to connect.) If you have to exit a configuration screen, restart NS Connection.

- Make sure the ESSID for your projector matches the SSID for your wireless card, adapter, or access point. If you have an AirPort base station, make sure the projector’s ESSID matches the AirPort network name. Remember that the ESSID is case-sensitive.

- Check the IP address for both your projector and your wireless card, adapter, access point, or AirPort base station. The first three segments of the IP address should be identical. The last segment of the projector’s IP address should be close, but not identical, to the last segment of the IP address for your wireless interface, access point, or base station.

- Restart your computer and start NS Connection again.

- If you still don’t see your projector, follow the instructions in “Connecting in IP Connect Mode” on page 89 to connect to the projector.

---

**note**

The AirPort network name may be different than the AirPort base station name. To check the network name, start the AirPort Admin utility, select your base station, and click Configure. Then click Show All Settings. The network name appears on the AirPort tab.
4. Once the name of your projector appears, select it and click **Connect**. If more than one projector is listed, you can select additional ones and connect to them at the same time. If the selected projector is already being used by another person, you can still connect to it; doing so automatically disconnects the other user.

5. If you set up the projector to prompt you for a keyword before connecting, you see a screen like this one:

   ![Enter keyword](image)

   Type in the four-digit number displayed on the EasyMP Network screen and click **OK**.

6. Once the connection is established, you see your computer’s image transmitted to the screen, and a floating control bar on your computer desktop:

   ![Control bar](image)

7. If necessary, you can drag the control bar out of the way on your screen.

8. When you’re done with your presentation, click **Disconnect** on the control bar.

---

**note**

If you want your presentation encrypted, click **Extension** and select **Use encrypted communication**. This step enhances security but decreases the data transmission speed.
**Using the Control Bar**

From the control bar, you can access these NS Connection features:

- ![Help icon](image1.png) Provides help for NS Connection.
- ![Projector icon](image2.png) Lists projectors and specifies which ones are in use.
- ![Menu icon](image3.png) Lets you access the projector’s menu system from an HTML browser window. See page 149 for more information.
- ![Keep Image icon](image4.png) Lets you keep the projected image on screen, even if the image on your computer changes.
- ![Pause icon](image5.png) Turns off the image and sound.
- ![Zoom In icon](image6.png) Lets you zoom in on a part of your image.
- ![Brightness icon](image7.png) Lets you change the brightness, contrast, and color mode.
- ![Switch Video icon](image8.png) Lets you switch between the Video, and S-Video ports.
- ![Switch Source icon](image9.png) Lets you switch between the Computer/Component Video source and EasyMP.

Clicking one of the buttons on the control bar may cause a submenu to appear above the control bar. For example, clicking the ![Pause button](image10.png) displays the following submenu:

![Submenu Image](image11.png)

*Click to close*
If you’re using more than one projector, you can use the Projector drop-down menu to select the projector on which you want to make any of the following changes:

- **Brightness**
  Increase or decrease brightness.

- **Keystone**
  Click + to narrow the top edge of the screen, or - to narrow the bottom edge (this option functions like the Sync buttons on the projector’s control panel).

- **Contrast**
  Increase or decrease image contrast.

- **Color Mode**
  Lets you select from five preset modes to adjust the color and brightness for specific environments: sRGB for computer displays (the default when projecting from a computer with analog video), Dynamic for presentations in bright rooms, Presentation for presentations in dark rooms, Theatre for optimizing movie images (the default for video display), and Living Room for video games.

When you’re done, click the arrow in the upper right corner to close the submenu.
**Connecting in IP Connect Mode**

You can establish a connection manually using IP Connect Mode even if your projector and computer are on a different subnet (Access Point mode only) or connecting over different routers.

1. Start NS Connection (see page 83). You see this screen:

   ![Screen1](image1.png)

2. Click the **Extension** button. You see this screen:

   ![Screen2](image2.png)

   **note**

   Depending on your network, your projector and computer may connect over different routers even if they are in the same room. Try this method if you are unable to connect automatically.
3. Select **Use IP connect mode** and click **OK**. You see this screen:

4. Click **IP connection**. You see this screen:

---

**note**

You can add up to 16 projectors to the list. If you add more, NS Connection begins to delete projectors from the list, starting with the first projector added.

5. Enter the projector’s IP address and click **Search**.
The IP address appears in the Projector list and a searching icon displays:

![Searching Icon](image.png)

If the search fails to find a projector with the specified IP address, the searching icon turns into a question mark. If this happens, run EasyMP on your projector (see page 60) to check the projector’s IP address, then repeat this step.

6. Click the projector you want to connect to and click the Connect button. If more than one projector is listed, you can select additional projectors and connect to them at the same time.

7. If you are prompted for a keyword, enter the four-digit number displayed on the EasyMP Network screen and click OK.

The computer’s image is transmitted to the projector and appears on the screen. See page 86 for details about using the floating control bar on your computer desktop.

---

**note**

You can connect to a projector while another person is using it. Follow the steps on page 92.
Switching Between Users

To connect to the projector while another person is already using it (Access Point mode only), follow these steps.

1. Start NS Connection (see page 83). You see this screen:

2. Select the projector you want to use and click Connect.

   You see this message:

3. Click Yes to connect.

   The other user is automatically disconnected and notified about the interruption:
Removing the Wireless 802.11g Card

Follow these steps to remove the card from your projector.

1. If you’re running NS Connection, click Disconnect on the control bar.

2. Check the card indicator light to make sure it isn’t flashing or on. Then press the eject button. The button pops out.

3. Press the eject button again. The wireless card partially ejects.

4. Pull the card straight out. Then press the eject button back in to prevent it from being damaged.

caution
Never remove the card while the card indicator light is green or when projecting wirelessly. You may damage the card or lose data.
Presenting from a Memory Card, Digital Camera, or External Drive

The projector’s EasyMP feature lets you give presentations from a memory card or a digital camera connected to the projector with a USB cable. You can play movies, display graphics, or play a *scenario*, a format that lets you create your own slideshow using PowerPoint files, JPG image files, and BMP graphics files.

This chapter covers the following:

- Inserting the memory card in the projector and removing it
- Creating a slideshow on the fly
- Presenting image files from a digital camera
- Presenting image files from an external drive
- Creating a scenario
- Transferring your scenario to a memory card
- Presenting scenarios
- Supported file formats

**note**

To create a scenario, you need a memory card and a card reader on your computer. Also make sure you’ve installed the EMP SlideMaker software (available for Windows only), as described on page 185.

Depending on the type of card you have, you may also need an adapter to use it with the projector. See page 111.
Inserting a Memory Card in the Projector

Follow these steps to insert the memory card in the projector:

1. If necessary, insert the card into a PC card adapter. (ATA flash cards don’t require an adapter.)

2. Insert the card (with the adapter) into the projector with the label facing up. The projector does not have to be turned off before inserting the card.

Removing a Memory Card

When you’re done using the projector and want to remove the memory card, follow these steps.

1. Make sure the card is not in use (the indicator light next to the card slot should be off).

2. Press the eject button above the card slot.
   
   The button pops out.

3. Press the button again. The memory card is released, and you can remove it from the slot in the projector.

4. To remove the card from the adapter, pull it out as shown:

   \[\text{Insert card here}\]
   \[\text{Eject button}\]
   \[\text{Insert card here}\]

\textbf{note}

If a digital camera is connected to the projector, disconnect it before inserting the memory card. The memory card is not functional when a digital camera is connected.

\textbf{caution}

Never force the card into the slot; you could damage the projector.

\textbf{note}

If you are using CardPlayer, highlight the EJECT button and press Enter on the remote control. Then wait for the indicator light to go off before you eject the card.
Creating a Slideshow on the Fly

If you have a folder on your memory card containing an assortment of images, you can display them as a slideshow.

Displaying the Slideshow

First make sure the images are stored in a folder on the memory card. Then follow these steps:

1. Use the pointer button on the remote control to highlight the folder containing your images and press Enter.

2. From the drop-down menu, use the pointer to select Play Slideshow and press Enter. The images contained in the folder are presented as a slideshow.

Use the remote control to run the slideshow as described in the next section.

Controlling Your Slideshow

While your slideshow is running, use the remote control as follows:

- Press Enter or Page down to display the next slide or image, or to begin playing a movie.
- Press Page up to display the previous slide or image, or to replay a movie.
Press the appropriate side of the ⚫ pointer button to rotate a slide or image on the screen.

To exit the slideshow at any point, press the Esc button. Press the Enter button to confirm that you want to exit.

**Changing Timing and Other Settings**

For each folder on the memory card, you can set the display timing for your slides and change several other display settings.

1. Select the folder containing the images for the slideshow settings you want to change and press Enter.

2. From the drop-down menu, use the pointer to select Options and press Enter.

   You see this screen:

   ![EasyMP Options Menu]

3. Use the ⚫ pointer button to select from the following settings. After making a selection, press Enter to save the change.

   - **Continuous Play**
     Determines whether to repeat the display of images in the folder.

   - **Screen switching time**
     Sets the display time for each image. Choose No if you want to change slides manually.
Presenting from a Memory Card, Digital Camera, or External Drive

- **Display order**
  Lets you choose between displaying alphabetically by file name or by image file date.

- **Effect**
  Lets you choose from various transitions between slides, such as Dissolve or Wipe.

- **Mode switching**
  Lets you choose the mode to use when presenting slideshows, movies, or images, or editing a scenario on the projector.

  In **Guide mode**, a drop-down menu appears whenever you select an item and press Enter.

  In **Quick mode**, selecting a scenario, movie, or image file and pressing Enter starts the presentation; selecting a folder and pressing Enter opens the folder. To access the menus in Quick mode, press the Esc key.

4. When you’re done, highlight OK and press Enter. Your changes are permanently saved with each folder—even if you turn off the projector or remove the memory card.

**Presenting Image Files From a Digital Camera**

This section explains how to project individual image files on your digital camera using EasyMP CardPlayer and a USB cable connection.

Before you begin, make sure there is no memory card in the projector’s card slot. You cannot have the camera connected while a memory card is inserted; neither the camera nor the card will function with EasyMP CardPlayer.

Follow these steps:

1. Connect your digital camera (see page 56).
2. Turn on your digital camera.
3. Turn on the projector and the remote control, if they’re not already on.

**note**

Most digital cameras also have the ability to play internal slideshows. Depending on the kind of cable you have, you can connect a camera with a video or A/V out port to the projector’s **Video** or **S-Video** port and transmit your camera’s slideshow directly to the projector. You must press the **Video** or **S-Video** button on the remote control to select the correct signal source. See pages 52 or 53 for details.
Presenting from a Memory Card, Digital Camera, or External Drive

4. Select EasyMP as the source by pressing the EasyMP button on the remote control. If your camera complies with the DCIM standard, you’ll see a DCIM folder appear on the EasyMP CardPlayer screen.

5. Use the ◁ pointer button on the remote control to position the cursor on the folder and press Enter.

6. Select Open Folder in the drop-down menu. When the folder opens, you see another folder with your manufacturer’s name.

7. Position the cursor on the folder and press Enter.

8. Select Open Folder. You see your image files when the folder opens.

9. Position the cursor on the image file you want to project and press Enter.

10. Select View Image. The image is projected on the screen. If you want, you can press a side of the ◁ pointer button to rotate the image while you’re viewing it.

To end the slideshow, press the Esc button on the remote control, then select Exit and press Enter.

Presenting Image Files From an External Drive

This section explains how to project individual image or movie files from an external hard drive or flash memory drive using EasyMP and a USB connection.

Before you begin, make sure there is no memory card in the projector’s card slot. You cannot have a drive connected while a memory card is inserted; neither the drive nor the card will function with EasyMP.

Follow these steps:

1. Connect your external hard drive or flash memory drive (see page 56).
2. Plug in your external hard drive.

3. Turn on the projector and the remote control, if they’re not already on.

4. Select EasyMP as the source by pressing the EasyMP button on the remote control.

5. Use the \( \Theta \) pointer button on the remote control to position the cursor on the folder where your photos or movies are stored and press Enter.

6. Select Open Folder in the drop-down menu. When the folder opens, you see another folder with your manufacturer’s name.

7. Position the cursor on the folder and press Enter.

8. Select Open Folder. You see your image files when the folder opens.

9. Position the cursor on the image file you want to project and press Enter.

10. Select View Image. The image is projected on the screen. If you want, you can press a side of the \( \Theta \) pointer button to rotate the image while you’re viewing it.

To end the slideshow, press the Esc button on the remote control, then select Exit and press Enter.
Presenting from a Memory Card, Digital Camera, or External Drive

Creating a Scenario

A scenario is a combination of images, movies, and/or audio files that you can present from a memory card. The easiest way to create a scenario is to drag and drop a PowerPoint file on the EMP SlideMaker2 icon on your desktop. This automatically converts the file to a scenario that you can save to the memory card. Use this method if you have an existing PowerPoint presentation that you want to transfer to the projector.

If you prefer, you can create a scenario from scratch by combining a selection of PowerPoint slides, other graphics, and even movies (see page 104).

Converting a PowerPoint File to a Scenario

Follow these steps to convert a PowerPoint file to a scenario. Once the scenario is created, you can set up transitions as described on page 108.

1. Make sure the EMP SlideMaker program is closed.
2. Locate the PowerPoint file you want to use in My Computer or Windows Explorer.
3. Drag the file icon on top of the EMP SlideMaker2 icon on your desktop.
4. You see a message that some transitions are not supported. Click OK.

EMP SlideMaker 2 starts and your PowerPoint slides open one-by-one as they are converted. Do not interrupt this process or your PowerPoint file won’t be completely converted.
5. When you see a message that the slideshow is complete, left mouse-click or press Enter as prompted. You see your scenario as shown below. The scenario is made up of individual cells for each of the PowerPoint slides.

6. At this point, you can insert additional images or create transition effects between slides. (See “Building a Scenario from Different Files” on page 106 and “Setting Up Transitions” on page 108 for details.) If there are slides in the scenario that you don’t want to use, right-click those cells and select Inactivate.

7. Choose Save from the File menu.

EMP SlideMaker 2 automatically names your scenario SCNnnnn.sit (where nnnn is an automatically assigned number). It also creates a folder for it within your Program Files\EMP SlideMaker2 folder. However, you can choose Save As from the File menu and enter a new scenario name and folder location if you want.

Once your scenario is saved, you can transfer it to the memory card in your computer’s PC card (PCMCIA) slot (see page 111).

Note

You have to save the scenario on your computer’s hard drive before transferring it. Don’t save it directly to the memory card, or it may not play correctly.
Creating a Scenario from Scratch

Use this method when you want to create a scenario from a selection of PowerPoint slides, graphics, or movie files. You’ll need to set up your scenario file and folder, build the scenario, set up transitions, and check the scenario.

Setting Up the Scenario File and Folder

1. Double-click the EMP SlideMaker2 icon on your computer’s desktop (or click Start > Programs or All Programs > Epson Projector > EMP SlideMaker2).

   You see the EMP SlideMaker 2 screen:
2. Choose New from the File menu. You see the scenario Properties dialog box:

![Properties dialog box]

3. Type a name for your scenario file and folder that’s easy to remember, using up to eight capital letters and numbers. Then select from the following options:

- The default location for the scenario file and folder is in the `\Program Files\EMP SlideMaker2` folder. Click Browse to choose a new location.
- Click Configure BGM(W) to play an audio file during the scenario. A selection screen appears letting you choose a .WAV file. After you select the file you want, click the arrow button to the right of the option to play it.
- The Background Color appears around images that don’t fill the entire screen area. Select a new color, if desired.
- Select the Image Quality for imported PowerPoint slides. Higher-quality images look better on the screen but may take longer to appear.

4. Click OK. You return to the EMP SlideMaker 2 screen.

Continue with the instructions in the next section to build your scenario.

*note*

The scenario name you enter is also the name of the folder for your scenario on your hard drive.
Building a Scenario from Different Files

You can build your scenario from any of the following file types, either alone or in combination with other file types:

- PowerPoint slides, version 2000 through 2003 (file names have .PPT extension)
- JPEG files (with .JPG extension)
- Bitmap files (with .BMP or .DIB extension)
- Movie files (with .MPG extension); must be MPEG 2 (MPEG1 is not supported)

Follow these steps:

1. Use the navigation tools on the left side of the EMP SlideMaker 2 screen to locate the files you want to include in your scenario.

   PowerPoint, JPEG, bitmap, and movie files appear as icons in the file window.

2. Click the icon for each file that you want to preview. The preview appears in the thumbnail preview window. If you click a PowerPoint icon, thumbnail images are generated for all the slides in the PowerPoint file. If you click a movie file, an illustration of a film strip appears.

   **note**
   You can also use the instructions in this section to add files to an existing scenario.

   **note**
   Movie files included in a PowerPoint file cannot be played back on the scenario.

   **note**
   Thumbnail previews for PowerPoint slides will not appear if PowerPoint is not installed on your computer.
3. Drag and drop the files you want to include in your scenario from either the file window or thumbnail window into the scenario window. (You can also double-click a thumbnail to add the file to the scenario.)

To include a whole PowerPoint file (instead of individual slides), drag the PowerPoint icon itself into the scenario window. Dragging an entire file preserves the transitions set in PowerPoint.

4. Continue dragging files into the scenario window to build your presentation. Each slide appears in a numbered cell. The cell background color varies according to the type of file in the cell.

5. If you want, you can make changes to the scenario:
   - To rearrange cells, drag and drop them as necessary within the scenario window.
   - To delete a cell, right-click the cell and select Cut.
   - To check the animation for a slide, click its cell. A section appears at the bottom of the scenario window displaying each animation operation. (Slides using animation have an .EMA extension.)

You can also create transitions between slides, as described in the next section.

**Note**
Transition effects created in PowerPoint look smoother than those you add with EMP SlideMaker 2.

**Note**
Unless you change the transition setting, your slides will automatically advance after 30 seconds.
6. When you’re done, click the **Save** button or choose **Save** from the File menu. Then see page 111 to transfer the scenario to your memory card.

**Setting Up Transitions**

EMP SlideMaker 2 lets you set your slides to advance manually or automatically after a specified period of time. You can also choose from a variety of transition effects between slides.

1. Click the cell or cells for which you want to set up in the scenario window.

   To select more than one cell, hold down the **Ctrl** key while you click. To select all the cells, choose **Select All** from the Edit menu. Selected cells turn yellow.

2. Right-click the selected cell or cells. The cell menu appears:

   ![](image)
3. Click **Cell Properties**. You see this dialog box:

4. Choose how you want to advance to the next cell.
   - If you want to change slides manually using the remote control, select **On mouse click**.
   - If you want your slides to advance automatically, set the timing in the **Automatically after** box. You can set any length of time between 1 and 1800 seconds (30 minutes). Even if you select this setting, you can still change slides manually using the remote control.

5. To add a transition effect (such as a dissolve, fade, or wipe), select one of the **Animation Effects** settings and choose a **Direction** setting, if applicable.

6. When you’re finished setting up the transition for the selected cell or cells, click **OK**.

7. Click the **Save** button or choose **Save** from the File menu. Continue with the steps in the next section when you’re ready to transfer your scenario to a memory card.

---

**note**

Transition effects look smoother when you create them in the PowerPoint file itself and use that file to create a scenario.
Checking Your Scenario

You can play your scenario before you transfer it to a memory card to make sure it looks and sounds the way you want it to.

1. Use the navigation tools in the folders window to locate the scenario file you want to review. Click the file, then click File > Open to open the scenario.

2. Click Scenario Option(s) > Scenario Preview. The Scenario Preview window displays.

   If the scenario is set to advance automatically (see page 109), it begins to play. If it is set to advance each time you click the mouse, click the play button to go through your slides one by one.

3. Use the controls in the Scenario Preview window to pause, stop, rewind, or fast forward your scenario. When you’re done, close the window.
Transferring Your Scenario to a Memory Card

Once your scenario is saved, you can transfer it to a memory card. You can use any of the following standard Type II cards. Most require a PC card adapter to allow insertion into the projector (check with your computer dealer to purchase a PC card adapter).

- CompactFlash™
- SmartMedia™
- Memory Stick™
- Microdrive™
- ATA flash (does not require a PC card adapter)

Be sure to use the transfer process described below to ensure that the scenario plays properly:

1. Insert the memory card in your computer’s PCMCIA slot.
2. Start EMP SlideMaker 2 (see page 104).
3. Use the navigation tools in the folders window to locate the scenario file you want to review. Click the file, then click File > Open to open the scenario.
4. From the Scenario Option(s) menu, choose Send Scenario. You see a drive selection window:

   ![Drive Selection Window]

   Select your memory card drive

5. Choose the drive where your card is located and click OK.
6. Click OK again to confirm. Your scenario is transferred to the card.

Note

You have to save the scenario on your computer’s hard drive before transferring it. Don’t use Windows to copy the scenario to your memory card, or it may not play properly.

You must insert the memory card in your computer’s PCMCIA slot before you select Send Scenario from the Scenario Option(s) menu. If you don’t, you won’t be able to see the card’s drive in the drive selection window. If this happens, close and restart EMP SlideMaker 2.
Once the scenario is transferred, you see this message about your scenario’s autorun setting:

![Image of autorun dialog box]

The autorun setting means that the scenario will start playing whenever the projector is turned on (with the memory card in the projector).

7. Do one of the following:

- If you don’t want the scenario to run automatically, click **Cancel**. Skip to step 11 to remove the card and insert it in the projector.

- If you want it to run automatically, click **OK** and continue with the following instructions.

You see the Edit Autorun window:

![Image of Edit Autorun window]

8. To set a scenario to run automatically, select it from the list on the left side of the screen and use the `>` arrow button to move it to the list on the right.

---

**note**

If more than one scenario is set to run automatically, they will play in the order listed on this screen.
9. Click the **Revive** box if you want your scenario to repeat continuously. Clear the checkbox if you want it to play only once.

10. When done, click **OK**.

11. Remove the card from your computer. See your computer’s documentation if you need instructions on removing the card. If you’re using Windows 2000 or Me, you may first need to click an icon to stop or disconnect the card.

### Presenting Scenarios

Before you begin, insert the memory card containing the scenario into your projector, as described on page 96.

The follow these steps to present your scenario:

1. Turn on the projector, if it’s not already on.
   - If your scenario is set to autorun, it will start as soon as the projector warms up.
   - If your scenario is not set to autorun, you need to start it manually. Continue with the following steps.

2. Select EasyMP as the source by pressing the **EasyMP** button on the remote control. You see a screen like the one below.

   ![EasyMP Card Player](image)

   JPEG files are displayed as thumbnails. Other files or folders are displayed as icons. A scenario icon identifies a scenario file.

---

**note**

You cannot have a digital camera connected while the memory card is inserted. If you do, neither the camera nor the card will function with your projector’s software.
3. Use the \( \text{\textcircled{}} \) pointer button on the remote control to highlight your \( \text{\textcircled{}} \) scenario file and press Enter. A drop-down menu appears under the scenario.

4. Use the \( \text{\textcircled{}} \) pointer button to select Play Scenario and press Enter. In a moment, your scenario begins playing.

5. When you’re done with your presentation, use the \( \text{\textcircled{}} \) pointer button to highlight EJECT in the upper right corner of the screen, and press Enter on the remote control. When you see a message asking you to insert a LAN card or memory card, it’s safe to remove your memory card (see page 96 for instructions).

**Controlling Your Scenario**

While your scenario is running, use the remote control as follows:

- Press Enter or Page down to display the next slide or image, or to begin playing a movie.
- Press Page up to display the previous slide or image, or to replay a movie.
- Press the appropriate side of the \( \text{\textcircled{}} \) pointer button to rotate a slide or image on the screen.
- To exit the scenario at any point, press the Esc button. Press the Enter button to confirm that you want to exit.

**Editing Your Scenario on the Projector**

You can modify your scenario using EasyMP on the projector. This lets you make last-minute changes, such as changing the order of your slides or hiding individual slides. These changes are not permanently saved with the scenario, but remain in effect only as long as the card is in the projector and the projector is turned on.

1. Highlight the \( \text{\textcircled{}} \) scenario you want to edit, then press Enter.
2. From the drop-down menu, select **Edit** Scenario. You see thumbnail images of the slides in your scenario:

![Slide thumbnails](image)

3. To move a slide, select the slide you want to move and press **Enter**. From the drop-down menu, select **Move Files**. A yellow line (or “I-beam”) appears beside the slide.

   Use the ⊞ pointer button to move the I-beam where you want to insert the slide and press **Enter**. The slide moves to the new position.

4. To hide a slide, highlight the slide you want to hide and press **Enter**. From the drop-down menu, select **Show/Hide**.

   If you change your mind and want to display the slide again, repeat this step to make the slide visible.

5. When done, highlight the **OK** button and press **Enter**.
Supported File Formats

The following file types may be projected from a memory card, digital camera, external hard drive, or flash memory drive:

<table>
<thead>
<tr>
<th>File Type</th>
<th>Extension</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario</td>
<td>.sit</td>
<td>These are scenario files created using the EMP SlideMaker 2 program that is included with the projector.</td>
</tr>
<tr>
<td>Graphics</td>
<td>.bmp</td>
<td>Only 24-bit color files can be played.</td>
</tr>
<tr>
<td></td>
<td>.gif</td>
<td>Images with a resolution greater than 1024 × 768 cannot be projected.</td>
</tr>
<tr>
<td></td>
<td>.jpg</td>
<td>Projection is not possible for CMYK color formats, progressive formats, and images with a resolution in excess of 2560 × 1920.</td>
</tr>
<tr>
<td></td>
<td>.png</td>
<td>Projection is not possible for images with a resolution in excess of 2560 × 1920.</td>
</tr>
<tr>
<td>Movie</td>
<td>.mpg</td>
<td>MPEG2-PS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the movie exceeds a maximum size of 720 × 576, or is not in the same form as a DVD (sequence header arranged for each GOP) it cannot be played back.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The reproducible audio format is MPEG-1 Layer 2. Linear PCM and AC-3 audio cannot be played back.</td>
</tr>
<tr>
<td>DPOF</td>
<td>.mrk</td>
<td>For DPOF version 1.10, only files named AUTPLAYx.mrk (where x is a number between 0-9) can be projected.</td>
</tr>
</tbody>
</table>

JPEG files with the extension “.jpeg” and “.mpeg” can’t be projected. Rename or save files as “.jpg” or “.mpg.” JPEG files with high compression will not look good. Movie files may not look as good from media with a slow access speed.
Fine-Tuning the Projector

You can use the projector’s on-screen menus to adjust the image, sound, and other features. This chapter covers the following information:

- Using the menu system
- Adjusting the image quality
- Adjusting the image size, shape, and position
- Adjusting the color
- Adjusting the sound
- Using the projector security features
- Controlling multiple projectors
- Customizing projector features
- Enabling Quick Setup options
Using the Menu System

You can use the remote control or the projector’s control panel to access the menus and change settings. Follow these steps:

1. To display the menu screen, press the **Menu** button.

   You see a menu screen similar to the one below:

   ![Menu Screen Example]

   The menus are listed on the left and the options available for the highlighted menu are shown on the right.

2. Use the **pointer** button on the remote control (or the arrow buttons on the projector) to scroll through the menu list. When you’ve highlighted the desired menu, press the **Enter** button to select it.

3. Once you’ve selected the menu, use the **pointer** button to scroll through the list of options. (Some of the options may be grayed out or unavailable, depending on the selected source.)

4. After highlighting the option you want to adjust, use the **pointer** button to change the setting. In some cases, you may have to press the **Enter** button to view a sub-screen for changing the setting.

   ■ Press the left or right side of the **pointer** button to adjust a slider bar.

   ■ To select from two or more settings, use the **pointer** button to highlight the desired setting and press **Enter**.
5. After changing the settings, press the Esc button to save your changes and return to the previous menu (or press it repeatedly to exit the menu system).

You can also press the Menu button to exit.

**Restoring the Default Settings**

You can use the menu system’s Reset options to restore the factory-default settings for all the settings listed in a specific menu, or all the settings in all menus.

To restore the settings in a specific menu, enter the menu whose settings you want to change, select **Reset**, and confirm as needed. (The example below shows how to reset the Settings menu.)

![Menu System Reset Options]

To restore all the projector settings to their factory-default values, select the **Reset** menu, highlight **All Reset**, and press **Enter**.

**note**

When you select All Reset in the Reset menu, it does not reset the Computer Input, User’s Logo, Language, Projector ID, Network, and Lamp settings.
**Adjusting the Image Quality**

You can use the Image menu to adjust the brightness, sharpness, color, tint, and contrast. If you’re projecting from a computer, there are additional adjustments you can make (see page 121).

**Adjusting the Image**

1. Press the Menu button on the remote control and select the Image menu. You see the Image menu screen.

2. Use the pointer button to highlight the desired option, then adjust it as needed:

   - **Color Mode**
     
     Lets you quickly adjust the color and brightness for various environments. Use either the remote control or the Color Mode setting in the Image menu. You can save a different setting for each computer and/or video source. Select from these settings:

     - **Dynamic**: For projecting movies or playing video games in vivid color in a bright room.
     - **Presentation**: For presentations in dark rooms.
     - **Theatre**: For optimizing movie images with natural color in a dark room (the default for video or S-Video display).
     - **Living Room**: For playing video games and watching TV in a bright room.
sRGB: For standard sRGB computer displays (the default when projecting from a computer with analog video).

- **Brightness**
  Lightens or darkens the overall image.

- **Contrast**
  Adjusts the difference between light and dark areas.

- **Sharpness**
  Adjusts the sharpness of the image.

- **Color Adjustment**
  Adjusts the tint of the image (not available for RGB video images).

### Adjusting Signal Settings

Although the projector normally detects and optimizes the input signal automatically, you can use the Signal menu to make manual adjustments. In addition to changing the position of the projected image, you can correct tracking and sync for computer images, or change the aspect ratio to widescreen format for video images.

1. Press the **Menu** button on the remote control and select the **Signal** menu.

   You see a screen similar to the one below. (The settings will be different depending on the source you are projecting from.)

   - **Auto Setup**
   - **Resolution**
   - **Sync**
   - **Position**
   - **Preset**
   - **Computer1 Input**
   - **Computer2 Input**
   - **Reset**

   ![Signal Menu Screen](image)

   **note**

   *The Brightness setting changes the opacity of the projector’s LCD panels. You can also change the lamp’s brightness. Select Brightness Control in the Setting menu, then choose High or Low (the default setting is High).*

   **note**

   *You can also use the remote control’s Auto button to automatically reset the projector’s tracking, sync, resolution, and position settings. See page 28 for details.*

---

*Fine-Tuning the Projector* 121
2. Use the \( \bigcirc \) pointer button to highlight the desired option, then adjust it as needed:

- **Auto Setup**
  Leave this setting **ON** to automatically optimize the computer image. Turn it off if you want to save adjustments you have made to the video settings.

- **Resolution**
  If your image is distorted (compressed, stretched, partially cut off, or doesn’t completely fill the display area), the projector’s resolution setting may not match that of your computer. Select **Auto** to let the projector adjust the resolution automatically, or **Manual** to adjust the setting yourself. (Press **Enter** after you make the selection.)

- **Tracking**
  Adjust this value to eliminate vertical stripes in the image.

- **Sync**
  Adjust this value if the image appears blurry or flickers.

- **Position**
  If the image is slightly cut off on one or more sides, it may not be centered exactly. Select this setting and use the \( \bigcirc \) pointer button to center it.

- **Preset**
  Once you’ve fine-tuned the settings in the Signal menu for the computer you’re using, you can save them as a group using one of the ten **Preset** settings. The next time you use the same computer, simply press the **Preset** button on the remote control to recall your saved settings. (Press the **Preset** button repeatedly to select the number corresponding to the setting you want to use.)

- **Computer 1 Input/Computer 2 Input**
  If the colors don’t look right on the **Auto** setting, select the setting for the type of equipment you’ve connected to the Computer/Component port(s):

  - **RGB**: For a computer connection.
Component Video: For a video player that outputs a component video signal.

Progressive: Use Film/Auto for projecting film or to automatically determine the setting, choose Video for video images, or choose OFF to convert each field of interlaced signals to progressive signals.

- Video Signal
  Leave this setting at Auto unless you are using a 60-Hz PAL system (select PAL60).

Adjusting the Image Size, Shape, and Position

Whether you’re projecting from a computer or video player, you can use these settings to adjust the size, shape, and position of the image.

- **Resize button**
  Adjusts how an image fits into the display area.

  For computer images, resizing is normally unnecessary, since the projector automatically resizes the image to make the best use of the display area. If you press the Resize button on the projector or remote control, the projector displays the image at the output resolution of the computer (which makes the image larger or smaller, depending on its resolution). If the resolution of the image is the same as the projector’s (1024 × 768), pressing Resize has no effect.

  For video images, pressing Resize switches the aspect ratio between 4:3 and 16:9. This lets you play certain digital video images or movies recorded on certain DVDs in 16:9 widescreen format.

- **Keystone** (in the Setting menu)
  Squares up the shape of the image after the projector has been tilted upward or angled to one side (see page 26). If you notice lines or edges looking jagged after adjusting the shape, decrease the Sharpness setting (see page 120).

*note*

If your computer image is stretched, compressed, or doesn’t fit correctly on the screen, try adjusting the Resolution setting first (see page 122).
Position (in the Signal menu)
If the image is slightly cut off on one or more sides, it may not be centered exactly. Select this setting and use the pointer button to center it (not available for digital RGB or RGB video images).
Adjusting the Color

The projector provides several ways for you to adjust the color:

- **Color Mode button** (also in the Image menu)
  Lets you quickly adjust the color and brightness for various environments. Use either the remote control or the Color Mode setting in the Image menu. You can save a different setting for each computer and/or video source. Select from these settings:

  - **Dynamic**: For projecting movies or playing video games in vivid color in a bright room.
  - **Presentation**: For presentations in dark rooms.
  - **Theatre**: For optimizing movie images with natural color in a dark room (the default for video or S-Video display).
  - **Living Room**: For playing video games and watching TV in a bright room.
  - **sRGB**: For standard sRGB computer displays (the default when projecting from a computer with analog video).

- **Color Adjustment** (in the Setting menu)
  Adjusts the color temperature. Select Color Temp. to set a temperature between 5000 and 10000 °K. Or select RGB to adjust individual red, green, and blue values. (Not available if sRGB is selected as the Color Mode setting.)
**Adjusting the Sound**

You can use the Audio settings to adjust the sound volume or tone.

1. Press the **Menu** button on the remote control and select the **Setting** menu.

2. Choose **Audio** and press **Enter**.

You see the Audio menu settings:

3. Use the \( \text{\textlangle\textrangle} \) pointer button to highlight the desired option, then adjust it as needed:

   - **Volume**
     
     Adjusts the volume.

   - **Tone**
     
     Adjusts the quality of the sound.

**Using the Projector Security Features**

To prevent unauthorized use of the projector, you can do the following:

- Assign a password; this can be disabled for a set period if you want to loan the projector to someone. See page 127.

- Create an identifying user logo that is displayed at startup and/or when the **A/V Mute** button is pressed. See page 130.

- Disable the projector’s buttons; this is useful, for example, if you’re projecting in a classroom and you want to ensure that no one touches the projector’s buttons while you’re using the remote control. See page 131.
If you create a user’s logo for the projector, you can set up the logo so it is displayed as the startup screen and/or AV/Mute screen. Unauthorized users cannot turn it off or change it. This feature is intended to discourage theft and provides a way to identify the projector should it be stolen.

**Enabling Password Protection**

To prevent unauthorized use, you can assign the projector a password. If you do, a screen will appear requesting the password whenever the projector is plugged in and turned on. If an incorrect password is entered three times in succession, the projector’s operation is locked and the power cord must be disconnected and reinserted to redisplay the password screen. If an incorrect password is entered thirty times in succession, the user must contact Epson to unlock the projector.

The default setting for the Password Protect function is **OFF**. Follow these steps to turn password protection on:

1. Press the **Freeze** button on the remote control for about five seconds.
   
   You see this screen:

   ![Password Protect Screen]

2. Use the ⬇️ pointer button to set **Power ON Protect** to **ON**. Then press **Enter**.

3. Select **Password** and press **Enter**.

4. When you see a message asking if you want to change the password, select **Yes** and press **Enter**.

   **note**
   
   It’s a good idea to write down your password.
   
   If you leave the projector plugged in, the Password Protect Release screen will not appear. You only need a password if you unplug and reconnect the power cable.

   **caution**
   
   If you lose the remote control, you will not be able to enter the password. Keep the remote control in a safe place at all times.
5. Press the Num button on the remote control. When it lights, the numeric keypad is activated.

6. Use the numeric keypad to enter a four digit password. (The default setting is 0000.)

7. When you see a confirmation message, reenter the password. Then press the Menu button to exit the screen.

8. Press the Num button on the remote control to deactivate the numeric keypad.

9. If you want to disable the password temporarily, select Timer and press Enter. Then hold down the Num button while you use the numeric keypad to enter the number of hours (from 0 to 9999) that you want the password feature disabled. If you want the projector to request the password every time it is turned on, set the timer to 0H.

   The countdown for the elapsed time begins as soon as you close the Password Protect menu. (You can check the elapsed time in this menu next to Time elapsed.)

10. To enable your screen logo, select User’s Logo Protect and press Enter. Select ON and press Enter.

    When this feature is on, the logo appears whenever you turn on the projector (if the Startup Screen is enabled in the Extended menu; see page 130). It also appears when you press the A/V Mute button (if you selected the Logo as the Background Color in the Extended menu). None of the User’s Logo features in the Extended menu can be changed when the User’s Logo Protect function is enabled.
Starting the Projector with a Password

When the password function is enabled, you see this screen when you plug in and turn on the projector:

1. Press the Num button on the remote control to activate the numeric keypad.
2. Enter the four digit password.

The password screen closes, the numeric keypad is automatically deactivated, and projection begins.

If the password is not correct, you see the message **Wrong password. Please try again.** If you enter an incorrect password three times in succession, you see the message **The projector’s operation will be locked. Request code xxxxx** and the projector switches to standby mode for approximately 5 minutes. Write down the request code. Then disconnect the projector’s power cord from the electrical outlet, reconnect it, and turn the projector back on.

When you see the Password Protect Release screen again, you can try to enter the correct password.

If you have forgotten the password, contact Epson with the request code number that appears in the Password Protect Release screen for assistance. See “Where To Get Help” on page 181.

If you enter an incorrect password 30 times in succession, the projector remains locked and you must contact Epson to unlock it.
Creating Your Own Startup Screen

You can transfer any image from your computer or video source to the projector and then use it as your startup screen. You can also use it as the screen displayed when the projector is not receiving a signal or when you press the A/V Mute button. The image can be a company logo, slogan, photograph, or any other image you want to use.

Capturing the Image

Start by displaying the image you want to use from either a computer or video source, such as a DVD player or digital camera. Then follow these steps to capture the image and transfer it to the projector:

1. Press the Menu button on the remote control, highlight the Extended menu, and press Enter.
3. When you see a message asking whether you accept the present image as the user’s logo, select Yes and press Enter. A selection box displays over the image.
4. Use the pointer button to select the area of the image you want to use. Then press Enter.
5. When you see the message Select this Image?, highlight Yes and press Enter.
6. Use the arrow buttons to select a zoom rate (display size) and press Enter.
7. When the message **Save image as user's logo?** appears, select **Yes** and press **Enter**. Saving the logo may take a few moments. Do not use your projector or video source while the logo is being saved.

8. When you see the message **Completed**, press **Esc** to return to the menu screen.

**Choosing When to Display the Image**

After your image is saved, it is automatically set as the startup screen. You can also save it as the screen you see when there’s no signal or when you press the **A/V Mute** button (see page 37).

1. Press the **Menu** button, highlight the **Extended** menu, and press **Enter**.

2. Select **Display** and press **Enter**.

3. Select the screen(s) on which you want your image to appear:
   - Highlight **Display Background** to display your image (instead of a blank screen) when there is no video signal coming from the currently selected source. Then press **Enter**.
   - Highlight **A/V Mute** to display your image when you press the **A/V Mute** button. Then press **Enter**.

4. Select **Logo** and press **Enter**.

5. When you’re finished, press **Esc** to exit.

**Disabling the Projector’s Buttons**

When you enable the Operation Lock function, you can lock all the projector’s buttons, or you can lock some of the projector’s buttons.

1. Press the **Menu** button, highlight the **Setting** menu, and press **Enter**.

2. Select **Operation Lock** and press the **Enter** button.

3. Select **Full Lock** or **Partial Lock** and press **Enter**.

4. Select **Yes** and press **Enter** to confirm the setting.

5. Press the **Menu** button to exit.
Controlling Multiple Projectors

If you're using more than one projector for your presentation, you can switch between them using a single remote control. To do this, you need to set a different ID for each projector. During the presentation, you can change the remote control's ID to match that of the projector you want to use.

Setting the Projector ID

The projector’s default ID is 1. Follow these steps to change it:

1. Press the Menu button on the remote control.
   You see the projector’s menu screen.
2. Select the Extended menu and press Enter.
3. Highlight Projector ID and press Enter.
4. Choose an ID value for the projector and press Enter.
5. When you’re done, press Esc to exit the menu system.
Changing the Remote Control ID

To change the remote control’s ID to match the projector’s ID, follow these steps:

1. Press the ID button on the remote control. You see it light.
2. Press one of the numbered buttons on the remote control to select the ID of the projector you want to operate.

   The ID button’s light shuts off and the new ID is registered.
3. Repeat steps 1 and 2 each time you want to switch projectors.

To check the remote control’s current ID, do the following:

1. Press the ID button twice. After a moment, the button flashes.
2. Count the number of flashes; this number corresponds to the remote control’s ID. (If it doesn’t flash, the ID is set to zero.)
Customizing Projector Features

You can use the menu system to turn Standby Mode on or off, adjust the network settings, select the projection mode, change the language, and turn Sleep Mode on or off.

Remote Monitoring Setup Options

These options let you set up the projector so it can be monitored and controlled from a remote computer (see page 138).

- **Standby Mode** (in the Extended menu)
  Select **Network ON** to enable the projector to be monitored over a network when it’s in standby mode.

- If you want to monitor the projector using a network management utility, select **SNMP** in the Network menu and enter at least one trap IP address.

Miscellaneous Setup Options

- **Projection** (in the Extended menu)
  Select **Front** (to project from the front of a screen and right side up), **Front/Ceiling** (when the projector is mounted upside-down from the ceiling), **Rear** (to project from behind onto a transparent screen), or **Rear/Ceiling** (to project from behind onto a transparent screen when the projector is mounted upside-down from the ceiling).

- **Language** (in the Extended menu)
  Select from nine languages to be used for the projector menus.

Enabling Sleep Mode

In Sleep Mode, the projector automatically turns off the lamp when it has not received any signals for 30 minutes. This conserves electricity, cools the projector, and extends the life of the lamp. When you want to start projecting again, just press the **Power** button.

In the Extended menu, select **Operation, Sleep Mode**, and choose **ON** or **OFF**.
Enabling Quick Setup Options

Your projector can quickly detect and set up the focus, straighten the image, and adjust the colors for the surface the image is being projected on. Follow these steps to enable these features:

1. Press the Menu button on the remote control.
   You see the projector’s menu screen.

2. Select the Setting menu and press Enter. Then highlight Quick Setup and press Enter.

3. Select Quick Setup Options and press Enter.

4. Adjust any of these options:
   - Highlight Auto Focus to automatically focus the projector.
   - Highlight Auto Quick Corner to automatically straighten the image if it is not rectangular.
   - Highlight Wall Shot to project on walls or surfaces that are not white.

5. Press Enter, then highlight ON or OFF and press enter. Highlight Return and press Enter.

6. When you are done adjusting settings, press the Menu button to exit.
Automatically Running Quick Setup

To automatically run quick setup whenever you turn on the projector, follow these steps:

1. Press the Menu button on the remote control.
   You see the projector’s menu screen.
2. Select the Setting menu and press Enter. Then select Quick Setup and press Enter.
3. Select Startup Options and press Enter.
4. Select Quick Setup and press Enter.
5. Press the Menu button to exit.

**note**

Automatic Quick Setup works only when the projector is set to Front projection. See page 187 for more information.
Managing Projectors

The EasyManagement software for your projector lets you monitor and control your projectors from a remote computer:

- Use EMP Monitor (available for Windows only) to see your projectors’ status, switch image sources, and control basic settings.
- Use the mail notification function to receive e-mail alerts about possible problems.
- Use a network management utility running SNMP, such as HP OpenView, to manage your facility’s equipment from a pre-existing system.

You can also use NS Connection to register up to 16 projectors as a group. This allows you to provide quick and easy access to these projectors from other computers.

To use the EasyManagement software to manage your projectors, first install EMP Monitor as described on page 185. If you plan to create projector groups, also install EMP NS Connection. Then connect and configure each projector you want to monitor. You can connect the projector wirelessly in Access Point mode (as described on page 68) or over a wired network (as described on page 138).

This chapter covers the following information:

- Connecting the projector to and configuring it for a wired network
- Monitoring and controlling your projector with EMP Monitor
- Using e-mail alerts to warn you of problems
- Understanding notification messages
- Using a browser to monitor the projector
- Using projector groups
Connecting and Configuring the Projector on a Network

Before using the EasyManagement software to manage your projector(s), you have to connect each projector you want to monitor to your network and configure it with an appropriate IP address. You can connect and configure the projector wirelessly, as described on page 59, or you can connect it using the network port.

Follow these steps to connect and configure the projector for your network.

1. Connect the projector to your network using a commercially available 100baseTX or 10baseT network cable.
2. Turn on the projector (see page 18).
3. Press the EasyMP button on the remote control and press Enter.
4. If your network assigns addresses automatically, turn on DHCP.
   If your network does not assign addresses automatically, turn off DHCP and enter the projector’s IP Address, Subnet Mask, and Gateway Address, as needed.
   To enter numbers using the remote control, press the Num button until it lights, then use the number keypad shown below.

---

note
If you’re a network administrator, you can use the SNMP option to enter a trap IP address. This lets you receive trap alerts for the projectors you’re monitoring. You can also configure your wireless network to receive trap alerts. Your projector must be connected in Access Point mode. Select the SNMP button next to the Access Point mode box and enter the IP addresses of the computers to be notified of an SNMP trap.
When you finish changing an address in the network menu, press the Enter button (on the remote control) or the Auto/Enter button (on the projector).

5. When you’re done, highlight OK and press Enter.

**Using EMP Monitor**

EMP Monitor lets you use a remote computer to manage your projectors whether connected wirelessly or over a wired network. It lets you easily turn the projectors on or off (together or individually), switch image sources, and check their status.

Before using EMP Monitor, make sure you’ve installed the software (available for Windows only) as described on page 185. The computer you’re using to monitor the projector should already be connected to your network.

**Opening and Closing EMP Monitor**

To start EMP Monitor, click Start > Programs or All Programs > Epson Projector > EMP Monitor.

If you’ve added the program to the Startup programs folder, then it may already be open. If so, click the icon in the system tray on the lower-right corner of your screen to display the EMP Monitor window:

To close EMP Monitor, right-click the program icon shown above and select Exit.
Registering Your Projectors

Before you can monitor your projectors, follow these steps to register them:

1. Click Start > Programs or All Programs > Epson Projector > EMP Monitor or click the EMP Monitor icon in the taskbar. You see this screen:

   ![Screen showing EMP Monitor interface]

   Click here

2. Click Register projector. You see this screen:

   ![Register projector dialog box]

   Click here

   note
   If Auto detect fails to find the projector, your projector may not be connected or configured correctly for the network. See page 138 to configure your projector for a wired network, or page 62 to configure the projector for a wireless network.

3. Click Auto detect to locate projectors currently operating on the network. Or click Manual registration and enter the projector’s network IP address.
Any projectors found on the network are listed as shown below:

4. Select each projector you want to add by clicking its name, then clicking the **Add** button. When you’re done, click **Close**. You see this screen with a list of all registered projectors.

   ![List of Projectors](image)

   **note**
   To delete a projector from the list, highlight the projector name, and click **Delete**.

5. Click **Close**.

   ![List of Projectors](image)
You see the status of each of your registered projectors on the main EMP Monitor screen:

![EMP Monitor screen](image)

**Monitoring Your Projectors**

The EMP Monitor screen lets you monitor your projectors using the Status, Video Source, and Error icons shown below. These let you see which projectors are currently being used, from which source (or port) they are projecting an image, and if a problem occurs.

![Status icon, Video Source icon, Error icon](image)

For detailed status information, select the projector and click View details.

---

**note**

To monitor a projector when it’s in standby mode (plugged in but not turned on), you must select Network ON as the Standby Mode setting in the projector’s Extended menu (see page 134).

Remember that when Standby Mode is set to Network ON, the exhaust fan continues to operate after the projector has cooled down. This is normal.
The following table explains the meaning of the status icons:

**Status icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green" /></td>
<td>Projecting; no problems</td>
</tr>
<tr>
<td><img src="image" alt="Dark" /></td>
<td>Turned off; no problems</td>
</tr>
<tr>
<td><img src="image" alt="Green" /></td>
<td>Projecting; problems detected</td>
</tr>
<tr>
<td><img src="image" alt="Dark" /></td>
<td>Turned off; problems detected</td>
</tr>
<tr>
<td><img src="image" alt="Network Error" /></td>
<td>Network error (for example, not connected to the network or power cable disconnected). You may also see this error if <strong>Network OFF</strong> is selected in Standby Mode (see page 134).</td>
</tr>
</tbody>
</table>

The following table explains the meaning of the video source icons:

**Video source icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Computer/Component 1" /></td>
<td>Computer/Component 1</td>
</tr>
<tr>
<td><img src="image" alt="Computer/Component 2" /></td>
<td>Computer/Component 2</td>
</tr>
<tr>
<td><img src="image" alt="S-Video" /></td>
<td>S-Video</td>
</tr>
<tr>
<td><img src="image" alt="Video" /></td>
<td>Video</td>
</tr>
<tr>
<td><img src="image" alt="EasyMP" /></td>
<td>EasyMP</td>
</tr>
</tbody>
</table>
The following table explains the meaning of the error icons. See page 167 for recommended solutions to problems.

**Error icons**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Lamp replacement notification (the lamp is nearing the end of its life; see page 163)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>High-speed cooling in progress (the projector is getting too hot but continues to operate)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Overheating (projection turned off automatically)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Lamp out or lamp cover open</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Fan error</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Sensor error</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Internal problem</td>
</tr>
</tbody>
</table>

**Controlling Your Projectors**

The control buttons in the upper-right let you select video signals and turn projectors on or off. (Hold the mouse pointer over a button to see a description of its function.) Select the projector you want to operate (with the mouse pointer) before clicking one of the buttons.

---

**note**

To turn on a projector when it’s in standby mode (plugged in but not projecting), you must have selected **Network ON** as the Standby Mode setting in the projector’s Extended menu (see page 134).

Remember that when Standby Mode is set to **Network ON**, the exhaust fan continues to operate after the projector has cooled down. This is normal.
The following table explains the functions of the control buttons:

<table>
<thead>
<tr>
<th>Control buttons</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Image]</td>
<td>Turns the projector on</td>
</tr>
<tr>
<td>![Image]</td>
<td>Turns the projector off</td>
</tr>
<tr>
<td>![Image]</td>
<td>Changes the video signal to the Computer/Component 1 port</td>
</tr>
<tr>
<td>![Image]</td>
<td>Changes the video signal to the Computer/Component 2 port</td>
</tr>
<tr>
<td>![Image]</td>
<td>Changes the video signal to the S-Video port</td>
</tr>
<tr>
<td>![Image]</td>
<td>Changes the video signal to the Video port</td>
</tr>
<tr>
<td>![Image]</td>
<td>Switches the display to EasyMP</td>
</tr>
</tbody>
</table>

**Using E-mail Alerts**

You can set up e-mail alerts to warn you of problems with the projector on either a wireless network or a wired LAN connection.

1. Do one of the following:
   - Insert the Epson 802.11g wireless card and set up your projector to work in Access Point mode, as described on page 68.
   - Configure your projector for a wired network, as described on page 138.

2. Turn on your projector and remote control.

**note**

The projector must be plugged in (projecting or in standby mode) for you to be able to connect to it. To access a projector in standby mode, you must select Network ON as the Standby Mode setting in the projector’s menu system (see page 134.)

Remember that when Standby Mode is set to Network ON, the exhaust fan continues to operate after the projector enters standby mode.
3. Press the **EasyMP** button on the remote control to switch to EasyMP. You see the following screen:

![EasyMP Screen](image)

4. Select **Config** in the lower right corner of the screen and press **Enter** on the remote control.

5. When you see the screen below, select **Mail** and press **Enter**.

![Mail Screen](image)
You see the following screen:

![Screen Image](image)

6. For Mail Notification Settings, select **ON** and press **Enter**.

7. Highlight the **IP address of SMTP server** box and press **Enter**.
   The box turns yellow to indicate you are in input mode. You can enter numbers between 0 and 255. However, you cannot use the following IP addresses: 255.255.255.255, 224.0.0.0, or 127.x.x.x (where x is a number between 0 and 255).

8. Highlight the **Port Number** box and press **Enter**. Then enter the SMTP server port number. The default value is 25, but you can enter numbers between 1 and 65535.

9. Highlight the **Destination address 1** box and press **Enter**. Enter the e-mail address for the first computer that you want to receive e-mail alerts. You can enter a maximum of 53 single-byte alphanumeric characters.

   Use the 📆 pointer button on the remote control to enter letters. Press the top of the button to scroll through capital letters, and the bottom of the button to scroll through lowercase letters. You will also see punctuation marks, such as a period (.) and symbols, such as @. When you see the letter or symbol you want, press **Enter**. Then press the right side of the button to move to the next position. To correct a mistake, press the left side of the button to return to the previous position.

**note**
To enter numbers with the remote control, press the **Num** button. When the button lights up, the numeric keypad is active. Press the **Num** button again to exit numeric keypad mode.
10. If you want to send e-mail alerts to other computers, enter addresses for those computers in the Destination address 2 and Destination address 3 boxes.

11. Select the conditions under which an e-mail alert will be sent.

12. When you’re done, highlight the OK button at the top of the screen (you can either use the pointer button on the remote control or press Esc) and press Enter. Highlight the OK button again and press Enter to return to the main EasyMP Network Screen.

For help understanding e-mail alerts, see the next section.

**Understanding the Notification Messages**

If a projector experiences a problem, it sends an e-mail message to each of the addresses you provided using EMP NetworkManager. The message includes “Epson Projector” in the subject line.

The body of the message contains:

- The name of the projector
- The projector’s IP address
- A description of the problem

The problem descriptions are similar to the errors reported by EMP Monitor listed on page 144.

If a plus (+) sign appears, it indicates that a problem has occurred. A minus (−) sign appears when the problem is resolved.
Using a Browser to Monitor Projectors

If your projectors are connected to a network (802.11g or 802.11b wireless or wired LAN), you can use a standard web browser to monitor and control each one.

1. Do one of the following:
   - Make sure the projector is set up for your wired LAN network, as described on page 138. (Standby Mode in the Extended menu should be set to Network ON to monitor projectors in standby mode.)
   - Make sure the Epson 802.11g wireless card is inserted in the projector’s card slot and the projector is configured for Access Point mode, as described on page 68.

2. Open the web browser and enter the IP address of the projector you want to monitor in the browser window.

   If you’re not sure what address the projector is using, turn it on and switch it to EasyMP. Then choose Basic under Wired LAN or Wireless LAN and press Enter. You see a screen like this, which shows you the IP address:

   ![Screen showing IP address]

   **note**
   You can’t use your browser to monitor projectors if it is set up to connect via a proxy server.

   If you are using Microsoft Internet Explorer, use version 6.0 or later.

   The projector must be plugged in (projecting or in standby mode) for you to be able to monitor it.

   To access a projector in standby mode, you must select Network ON as the Standby Mode setting in the projector’s menu system (see page 134.)

   Remember that when Standby Mode is set to Network ON, the exhaust fan continues to operate after the projector enters standby mode.

3. If you’re connected over a wired network, the projector’s web screen opens in the browser window.
If you’re connected over an 802.11g wireless network, start NS Connection (see page 83) and connect to the projector you want to monitor. Then click on the control bar that appears on the screen. The projector’s web screen opens in the browser window.

4. Select one of the menu options listed on the left, then change any settings as needed in the main part of the screen. These settings correspond to those found in the projector’s menu system; for details, see page 118.

You cannot use the web browser to change these settings:
- **Pointer** in the Setting menu
- **User’s Logo** in the Extended menu
- **All Reset** or **Lamp-Hours Reset** in the Reset menu

5. Use the controls at the bottom of the screen just as you would the corresponding remote control buttons: choose a source, stop the action, control the volume, size the image, turn off the picture and sound, or turn the projector’s power on or off.

For details about the remote control, see page 32.
Using Projector Groups

You can register projectors as a group if you want to provide quick and easy access to other computers. You can also export or import group information as a file to another computer. Projectors must be connected to the network in Access Point mode, and must be on the same network segment as the computer used to create the group, or the computers that import or export group information.

Creating a Group

You can register up to 16 projectors as a group, and all projectors must be part of your wireless network.

1. Start NS Connection. (See page 83.)
2. Click the Extension button on the EMP NS Connection screen. You see this screen:

Select these two boxes

3. Select Use IP connect mode and Use Group List.

Tip

Use a static IP address when configuring a projector for the network if you plan to use it in a group. If you use DHCP, the projector’s IP address will change every time you turn it off and on again, and you will have to recreate the projector group.

If any of the octets in a static IP address are less than 100, the first digit of the octet should be zero (0).
4. Click the **Advanced** button. You see this screen:

![Advanced screen](image)

5. Enter a name for the group in the **Connection Group** box. Then enter the IP address of the projector you want to register in the **IP address** box:

![Advanced screen with example](image)

**note**

You cannot use the addresses 0.0.0.0 or 255.255.255.255.
6. Click Add. The IP address appears in the list of registered projectors and the searching icon appears beside it. If the projector is found, its name appears in the projector list.

7. Repeat steps 5 and 6 for each projector you want to add to the group.

8. Click OK to save the projectors as a group. When you see a confirmation message, click Yes.

9. Click Close to close the Advanced screen.

10. Click OK to close the Extension screen, then close NS Connection.

**note**

To remove a projector from the group, select it from the projector list and click Delete.
Follow these steps to connect to a projector in a group:

1. Start NS Connection. (See page 83.)

2. Click the Extension button on the EMP NS Connection screen. You see this screen:

   ![Extension Screen](image)

   Select these two boxes

3. Select Use IP connect mode and Use Group List.
4. From the Connection Group list, choose the group you want to connect to and click OK.

5. When you see the next screen, click IP connection. (If the upper left button on the screen says IP connect mode rather than Automatic search mode, skip this step.)

You see this screen:

6. Select the projector you want to connect to and click Connect.
7. If you want, repeat step 5 to connect to additional projectors. The computer’s image appears on the projector screen.

**Exporting a Projector Group**

You can export group information as a file to another computer on the wireless network. This is useful if you want to share group access with multiple users.

1. Start NS Connection. (See page 83.)

2. Click the **Extension** button on the EMP NS Connection screen. You see this screen:

   ![](image)

   Select these two boxes

3. Select **Use IP connect mode** and **Use Group List**.

   ![](image)

   Select these two boxes
4. Click the **Advanced** button. You see this screen.

5. Click **Export** to export a file for all groups in the Connection Group list.

6. Highlight the file name (**NSGroup.ini**) and select **Save to**.

7. Choose a location on the second computer and click **Save**.

To connect to the projector from the new computer, follow the steps beginning on page 154.

---

**note**

If you haven’t created any groups, the **Export** button will be grayed out. You must create at least one group before the **Export** button is active.
**Importing a Projector Group**

You can also import group information as a file to another computer on the wireless network.

1. Start NS Connection. (See page 83.)

2. Then click the **Extension** button on the EMP NS Connection screen. You see this screen:

3. Select **Use IP connect mode** and **Use Group List**.

4. Click the **Advanced** button. You see this screen.

### Advanced

By specifying the IP address of the networked projector, you can create a group of up to 16 projectors.
5. Click Import.

6. On the next screen, select the file you want to import and click Open.

   The names of all of the groups in the file are added to the Connection Group list on the Advanced screen.

To connect to the projector from the new computer, follow the steps beginning on page 154.
Maintaining the Projector

Your projector needs little maintenance. All you have to do is keep the lens clean and periodically clean the air filters at the side and base of the projector. A clogged air filter can block ventilation needed to cool the projector.

The only parts you should replace are the lamp and air filters. If any other part needs replacing, contact your dealer or a qualified servicer.

This chapter covers the following:

- Cleaning the lens
- Cleaning the projector case
- Cleaning the air filters and vents
- Replacing the lamp and air filters
- Transporting the projector

warning
Before you clean any part of the projector, turn it off and unplug the power cord. Never open any cover on the projector, except the lamp cover. Dangerous electrical voltages in the projector can injure you severely. Do not try to service this product yourself, except as specifically explained in this User’s Guide. Refer all other servicing to qualified service personnel.
Cleaning the Lens

Clean the lens whenever you notice dirt or dust on the surface.

Use a canister of compressed air to remove dust.

To remove dirt or smears on the lens, use lens-cleaning tissue. If necessary, moisten a soft cloth with lens cleaner and gently wipe the lens.

Cleaning the Projector Case

Before you clean the case, turn off the projector and unplug the power cord.

- To remove dirt or dust, wipe the case with a soft, dry, lint-free cloth.
- To remove stubborn dirt or stains, moisten a soft cloth with water and a neutral detergent. Then wipe the case.

Cleaning the Air Filters and Vents

Clean the air filters and air intake vents after every 100 hours of use. If they are not cleaned periodically, they can become clogged with dust, preventing proper ventilation. This can cause overheating and damage the projector.

Follow these steps:

1. Turn off the projector. Wait for the Power light to stop flashing, then unplug the power cord.
2. To clean the intake vents, use a small vacuum cleaner designed for computers and other office equipment. If you don’t have one, gently clean the vents with a soft brush (such as an artist’s paintbrush).

3. If the dirt is difficult to remove or a filter is broken, replace the filters as described on the next page. Contact your dealer or call Epson at (800) 873-7766 in the United States to obtain new ones. In Canada, please call (800) 463-7766 for dealer referral.

**Replacing the Lamp and Air Filters**

The life span of the projection lamp is about 2000 hours if Brightness Control in the Setting menu is set to High (default), and 3000 hours if Brightness Control is set to Low.

It is time to replace the lamp when:

- The projected image gets darker or starts to deteriorate.
- The message **Replace the lamp** appears on the screen when the lamp comes on and the lamp warning light \( \bigcirc \) flashes orange. To maintain projector brightness and image quality, replace the lamp as soon as possible.
- The lamp warning light \( \bigcirc \) flashes red (the lamp is burnt out).

Contact your dealer or call Epson at (800) 873-7766 in the United States for a replacement lamp. Request part number V13H010L31. In Canada, please call (800) 463-7766 for dealer referral.

---

**note**

When you get a replacement lamp for your projector, you should replace the filters.

To check how long the lamp has been in use, see page 171.

Turn off this product when not in use to prolong the life of the projector.
Maintaining the Projector

Follow these steps to replace the lamp and air filters:

1. Turn off the projector.
2. When the **Power** light stops flashing, unplug the power cord.
3. Let the projector cool for at least an hour (if it has been on). The lamp is extremely hot immediately after use.
4. Turn the projector over and remove the air filters at the side and bottom of the projector.

**warning**

Let the lamp cool fully before replacing it.

In the unlikely event that the lamp has broken, small glass fragments may be present and should be removed carefully to avoid injury.

5. Insert the two new air filters. They should click into place.
6. Turn the projector back over.
7. Loosen the screw holding the lamp cover in place (you don’t need to remove it). Then remove the lamp cover.
8. Loosen the two screws holding the lamp in place (you don’t need to remove them).

9. Grasp the handles as shown and pull the lamp straight out.

10. Gently insert the new lamp. (If it doesn’t fit easily, make sure it is facing the right way.)

11. Once the lamp is fully inserted, tighten its screws and replace the cover, then tighten the cover screw. (The projector won’t come on if the lamp cover is loose.)

12. Reset the lamp timer as described in the next section.

**Resetting the Lamp Timer**

After you replace the lamp, you need to reset the lamp timer using the projector’s menus.

1. Press the Menu button on the remote control or on the projector’s control panel. You see the main menu.
2. Use the \( \text{□} \) pointer button on the remote control (or the arrow buttons on the projector) to highlight **Reset**, then press **Enter**.

You see this screen:

3. Select **Lamp Hours Reset** and press **Enter**. You see this prompt:

4. Select **Yes** and press **Enter**.

5. When you’re finished, press **Esc** or **Menu** to exit.

---

### Transporting the Projector

The projector contains many glass and precision parts. Follow these guidelines to prevent damage:

- When shipping the projector for repairs, use the original packaging material if possible. If you do not have the original packaging, use equivalent materials, placing plenty of cushioning around the projector.

- When transporting the projector a long distance, first place it in a hard-shell shipping case, then pack it in a firm box with cushioning around the case. (An optional case is available from Epson; see page 13.)

---

*note  
Epson shall not be liable for any damages incurred during transportation.*
9 Solving Problems

This chapter helps you solve problems with your projector, and tells you how to contact technical support for problems you can’t solve yourself. The following information is included:

- Using the projector’s on-screen help system
- What to do when the projector’s status lights flash
- Solving problems with the image or sound
- Solving problems with EasyManagement
- Solving problems with the remote control
- Contacting technical support
Using On-Screen Help

If the image doesn’t look right or your audio isn’t working, you can get help by pressing the blue ? Help button on top of the projector or on the remote control. The following choices are available:

- Problems with image
- Problems with sound
- Language change

Follow these steps to get help:

1. Press the blue ? Help button on the projector.

You see the Help Menu:

2. Use the pointer button on the remote control or the arrow buttons on the projector to highlight menu items.

3. Press the Enter button on the remote control or on the projector to select the menu item.

4. To exit the help system, press the ? Help button.

If none of the suggestions solve your problem, see additional solutions to problems in the following sections.
**Checking Projector Status**

If your projector isn’t working correctly, first turn it off, wait for it to cool (the Power light stops flashing orange), and unplug it. Then plug the power cord back in and turn on the projector. If this doesn’t solve the problem, check the lights on top of the projector.

**What To Do When the Lights Flash**

The lights on top of the projector indicate the projector’s status.

Refer to the following table for a complete description of the projector’s status lights:

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Power light" /></td>
<td>Orange</td>
<td>The projector is in Sleep Mode. You can unplug it or press the Power button to turn it on.</td>
</tr>
<tr>
<td><img src="image" alt="Power light" /></td>
<td>Flashing green</td>
<td>The projector is warming up. Wait for the image to appear.</td>
</tr>
<tr>
<td><img src="image" alt="Power light" /></td>
<td>Green</td>
<td>The projector is operating normally.</td>
</tr>
<tr>
<td><img src="image" alt="Power light" /></td>
<td>Flashing orange</td>
<td>The projector is cooling down. You can’t turn it back on (and you should not unplug it) until the light stops flashing and remains orange.</td>
</tr>
<tr>
<td><img src="image" alt="Temperature light" /></td>
<td>Flashing red</td>
<td>There is a problem with the fan or temperature sensor. Stop using the projector, disconnect the power cable, and contact Epson.</td>
</tr>
</tbody>
</table>
## Status lights

<table>
<thead>
<tr>
<th>Light</th>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Flashing orange</td>
<td>Rapid cooling is in progress. Although this is not an abnormal condition, projection will stop automatically if the temperature rises higher. Make sure there is plenty of space around and under the projector for ventilation, and that the air filters and vents are clear.</td>
</tr>
<tr>
<td>!</td>
<td>Red</td>
<td>The projector is overheating, which turns the lamp off automatically. Wait until the cooling fan stops, then unplug the power cord. Plug the power cord back in and press the Power button. Make sure the room temperature is not above 95 °F (35 °C), and there is plenty of space around and under the projector for ventilation. The air filters may be clogged. Clean or replace them as described on page 162. If the projector continues to overheat after you clean the air filter, the problem may be caused by damage to the cooling fan or temperature sensor. Contact Epson for help. <strong>Warning:</strong> Except as specifically explained in this User’s Guide, do not attempt to service this product yourself.</td>
</tr>
<tr>
<td>⚡</td>
<td>Flashing orange</td>
<td>It’s time to replace the lamp. See page 163 for instructions. If you continue to use the lamp after the replacement warning, there is an increased possibility that the lamp may break.</td>
</tr>
<tr>
<td>⚡</td>
<td>Flashing red</td>
<td>The lamp may be burnt out. First make sure the lamp cover is securely installed. If that’s not the problem, let the lamp cool, remove the lamp, and replace it as described on page 163. If this does not resolve the problem, contact Epson as described on page 181.</td>
</tr>
<tr>
<td>⚡</td>
<td>Flashing red</td>
<td>Power is cut off because of an internal problem. Unplug the power cord and contact Epson for help, as described on page 181.</td>
</tr>
<tr>
<td>⚡</td>
<td>Red / Flashing red</td>
<td>The lamp may be cracked or installed incorrectly. Check the lamp; if it is cracked, you must replace it (as described on page 163) before you can use the projector again. Also make sure the air filters and intake vents are clean. (See page 162.) Make sure the lamp and cover are installed correctly. (See page 165.) If checking the lamp installation and replacing the lamp does not solve the problem, contact Epson as described on page 181.</td>
</tr>
</tbody>
</table>
Viewing Lamp Usage and Other Information

Use the Info menu to view information about the display settings of your computer and the number of hours the lamp has been used.

Press the Menu button and highlight the Info menu.

You see the lamp usage hours and various input signal settings on the right.

The life span of the lamp is about 2000 hours if the Brightness Control setting in the Setting menu is set to High (default), and 3000 hours if the Brightness Control setting is set to Low. Make sure you have a spare lamp handy if the usage hours on this menu are close to the life span of your lamp.

Solving Problems with the Image or Sound

No image appears on the screen.

- Check that the Power light is green, not flashing, and the lens cap is off.
- The projector may be in Sleep Mode. If the Power light is orange, press the Power button to turn the projector on.
- If the power was switched off and then on again, the projector may be cooling down. Wait until the Power light stops flashing and remains orange; then press the Power button again.
- Press the A/V Mute button to make sure the picture has not been turned off temporarily.
- The attached computer may be in sleep mode or displaying a black screen saver. Try pressing a key on the computer.

You’ve connected a computer and see a blue screen with the message No Signal displayed.

- Make sure the cables are connected correctly, as described on page 46.

Note

The information displayed depends on the input signal currently selected.
Try restarting your computer.

If you’ve connected a computer and one or more video sources, you may need to press one of the Source buttons on the projector or remote control to select the correct source. Allow a few seconds for the projector to sync up after pressing the button.

If you’re using a PC notebook:

Hold down the Fn key on the keyboard and press the function key that lets you display on an external monitor. It may have an icon such as CRT/LCD, or it may be labelled CRT/LCD. Allow a few seconds for the projector to sync up after pressing it. Check your notebook’s manual or online help for details.

On most systems, the CRT/LCD key lets you toggle between the LCD screen and the projector, or display on both at the same time.

Depending on your computer’s video card, you might need to use the Display utility in the Control Panel to make sure that both the LCD screen and external monitor port are enabled. See your computer’s documentation or online help for details.

If you’re using Macintosh OS X:

1. Open System Preferences.
2. Click Displays.
3. Make sure the VGA Display or Color LCD dialog box is selected.
4. Click the Arrangement or Arrange tab.
5. Make sure the Mirror Displays checkbox is selected.

If you’re using Macintosh OS 8.6 to 9.x:

1. From the Apple menu, select Control Panels, then click Monitors and Sound.
2. Click the Arrange icon.
3. Drag one monitor icon on top of the other. This lets you display on the projector screen as well as the LCD screen.
4. If this option isn’t available, click the Monitor icon.
5. Select one of the listed Simulscan resolutions. (Allow a few seconds for the projector to sync up after making the selection.)

The message Not Supported is displayed.

■ Make sure the correct input signal is selected in the Signal menu (see page 121).

■ Make sure your computer’s resolution doesn’t exceed UXGA (1600 × 1200) and the frequency is supported by the projector (see page 191). If necessary, change your computer’s resolution setting as described below.

Only part of the computer image is displayed.

■ Press the Auto button on the remote control.

■ Make sure the image Position setting is correct on the Signal menu. See Chapter 6 for more information.

■ Make sure your computer’s resolution setting is correct. Ideally, it should be 1024 × 768 to match the projector’s native resolution. If this option isn’t available, select one of the other compatible video formats listed on page 191.

■ Windows:
  Right-click the desktop, select Properties, click the Settings tab, and select a different resolution.

■ Macintosh OS X:
  Open System Preferences, click Displays, and select a different resolution.

■ Macintosh OS 8.6 to 9.x:
  On the Apple menu, choose Control Panels, and click Monitors and Sound. Select a different resolution.

■ You also may need to modify existing presentation files if you created them for a different resolution. See your software documentation for specific information.
The image isn’t square, but keystone-shaped.

- If the top or bottom of the image is broader, press the Sync + or Sync - button on the projector until the image is square.

- If the projector is angled toward the screen from the left or right, the image will be broader on one side. Center the projector in front of the middle of the screen, facing the screen squarely. If this doesn’t work, press the Tracking + or Tracking - button on the projection until the image is square.

- If the image has no parallel sides, use Quick Corner. Press the Menu button, select the Setting menu, and select Keystone. Select Quick Corner and make your adjustments with the pointer button. See page 36 for details.

The image contains static or noise.

- Make sure the correct input signal is selected in the Signal menu (see Chapter 6).

- If you’re using a computer cable longer than 6 feet, or an extension cable, the image quality may be reduced.

- Keep your computer and video cables away from the power cord as much as possible to prevent interference.

- The video signal may be split between the computer and the projector. If you notice a decline in the projected image quality when the image is displayed simultaneously on your notebook computer and the projector, turn off the notebook’s LCD display.

The image is blurry.

- There may be dirt or smears on the lens. Clean the lens as described on page 162.

- Adjust the focus using the focus buttons (see page 25).

- Make sure the lens is not fogged by condensation. You may need to wait before using the projector after moving it from a cold environment to a warm environment.
■ Adjust the **Sharpness** setting on the Image menu (see page 120). When you change video settings, you should be able to see the effect on the screen immediately. If you’re projecting from a computer, you may also need to adjust the tracking and sync as described in the next section. If you don’t like the new settings, you can always select **Reset** to return to the factory default settings.

**You see vertical bands or the image still looks blurry after trying the solutions in the previous section.**

■ If you’re projecting from a computer and displaying an image that contains a lot of fine detail, you may notice vertical bands or some of the characters may look heavy or blurred. Press the **Auto** button on the remote control to reset the projector’s tracking and sync settings.

■ If further adjustment is needed, you can fine-tune the **Tracking** and **Sync** settings manually using the buttons on the projector.

1. Fill the screen with an image containing fine detail, such as pattern to appear as your desktop background, or try projecting black text on a white background.

2. Adjust the **Tracking** to eliminate vertical bands.

3. Adjust the **Sync** setting to increase the image sharpness.
The image colors are incorrect.

- If you’re displaying a computer image, use the Color Mode option in the projector’s Image menu to adjust the color. If you’re displaying video, adjust the Color Adjustment and Color Mode settings on the Image menu.

- Check your computer display settings to correct the color balance.

There is no sound.

- Make sure A/V Mute is not enabled. (The A/V Mute button may have been pressed.)

- Try adjusting the Volume setting in the Setting menu (see page 126).

- If you’re using a VCR or other video source, make sure the volume is not turned all the way down or muted. Also, make sure the cables are connected correctly, as described in on page 57.

- If your presentation includes computer audio, make sure the volume control on your computer is not turned all the way down or muted. If you’re using the audio cable, make sure it is securely connected to both the projector and your computer’s headphone jack or audio out jack.

- Make sure the Windows volume controls on your computer are not turned all the way down or set to Mute. You may be able to check this by clicking the volume control in your Windows system tray (lower right corner of the screen).
Solving EasyManagement Problems

You don’t see your projector in the EMP Monitor window.

■ Make sure that you’ve connected the projector to the network and configured it correctly; see page 138 or page 62. Also, make sure you’ve registered the projector with EMP Monitor; see page 139.

■ Make sure that Standby Mode in the projector’s Extended menu is set to Network ON.

■ If the computer you are using is running Windows XP or 2000, you must be logged in as the Administrator.

■ Try restarting your computer.

You can’t connect to the projector using NS Connection.

■ Make sure you’ve installed the Epson 802.11g card correctly in the projector; see page 60. If you have to reinstall the card, restart NS Connection or the program will not be able to detect the projector.

■ Restart your computer.

■ Make sure your projector and computer are configured correctly; see page 62 (Ad Hoc mode) or page 68 (Access Point mode).

■ Make sure that you have sufficient wireless signal strength (above 50 percent). On a Macintosh, check the AirPort icon on the Macintosh menu bar. In Windows, see the documentation for your computer’s wireless card or adapter for details.

■ Make sure you aren’t projecting one of the EasyMP configuration screens. (You should see a message that the projector is ready to connect.) If you have to exit a configuration screen, restart NS Connection.

■ If the projector is configured for Access Point mode and you’re using DHCP, allow time for your projector to appear. It takes the server a little while to pick up the IP address.
If you’ve changed any settings for your projector or network, or restarted your computer, allow a minute or two for the connection to appear. If you’re using AirPort, try turning AirPort off and then on again.

Make sure that you’re trying to connect to the right network. In Windows, verify that you’ve enabled your computer’s connection to the access point (see page 75) or that your wireless card or adapter is enabled and its SSID is set to match the projector’s ESSID (see page 66). On a Macintosh, click the AirPort icon at the top of your Macintosh desktop to make sure AirPort is turned on and the projector’s ESSID or your AirPort network is selected.

If you have an access point or AirPort base station and you’re not using DHCP, check your projector’s IP address on the Access Point mode advanced settings screen. The first three segments of the IP address should be identical to the first three segments of the IP address of your access point or base station. The last segment of the projector’s IP address should be close, but not identical, to the last segment of the IP address of the access point or base station.

If you’re not using DHCP, check your projector’s Gateway address on the projector’s Access Point mode advanced settings screen. It should be identical to the IP address for your access point or AirPort base station.

If you’re using a projector keyword, it changes each time you turn the projector off and then on again, or remove and reinsert the 802.11g wireless card. Check the projector’s keyword on the EasyMP Network screen and enter it at the prompt.

If you’re using AirPort, check the configuration of your network. Start the AirPort Admin utility, select your base station, click Configure and click Show All Settings. Click the Network tab. If you set up your projector to connect in DHCP mode, turn on Distribute IP Addresses and Share a Single IP Address.

If you’re using AirPort and DHCP is turned off on your projector’s Access Point mode advanced settings screen, make sure Distribute IP Addresses is off.
If you’re using Access Point mode and you’re connecting to the wrong network, you may be experiencing signal interference from another network. Try resetting your access point or base station, then restart NS Connection.

If you’re using AirPort, the projector’s ESSID should match the AirPort network name, not the name of the AirPort base station. To check the network name, start the AirPort Admin utility, select your base station, and click Configure. Then click Show All Settings. The network name appears on the AirPort tab.

If you’re prompted for a password when you connect, enter the WEP encryption key (if you’re using WEP encryption).

Try connecting using IP Connect Mode; see page 89.

An image displayed with EasyMP appears distorted.
Because of their resolution, some JPEG images cannot be displayed correctly. Some JPEG files from digital cameras cannot be previewed. Files with a high compression ratio may appear blurry.

In EMP SlideMaker 2, PowerPoint files don’t appear in the file window.
EMP SlideMaker 2 does not support PowerPoint 95. Files created in this version of PowerPoint must be opened and resaved in PowerPoint 97 or later.

In EMP SlideMaker 2, your PowerPoint files don’t display thumbnails and can’t be pasted into scenarios.
If you use PowerPoint 97, make sure the MS Office JPEG converter has been installed. Run the Office 97 installer, display the Converts and Filters option, and install the JPEG filter. Also, make sure PowerPoint is installed on the computer you’re using to build the scenario.

Your PowerPoint movie file does not play back.
Movies files inside a PowerPoint file cannot be played on the scenario.
You can’t edit scenario files in EMP SlideMaker after they have been transferred to the memory card.

You can only edit scenarios before they are transferred. Open the scenario files saved on your hard drive, make any changes, then transfer the scenario to your memory card.

You can’t transfer your slideshow to the memory card because you aren’t able to see the card’s drive letter.

You must insert the memory card in your computer’s PCMCIA slot before you select Send Scenario from the Scenario Option(s) menu. If this happens, close and restart EMP SlideMaker 2. Make sure your card is inserted before you select Send Scenario.

You can’t play your movies on the projector.

The projector only supports MPEG2 files. It does not support MPEG1 files.

EasyMP is unable to see the image files on your camera or external drive.

Make sure your camera or drive shows up on your desktop as a drive letter when you connect it to your computer. If it does, it is probably a USB-mounted device and will work with your projector. The projector does not support TWAIN-compliant digital cameras.
Solving Problems with the Remote Control

The projector doesn’t respond to remote control commands.

- Be sure the ON/OFF switch is in the ON position, as shown on page 19.
- The remote control’s batteries may not be installed correctly or may be low on power. To change the batteries, see page 33.
- Make sure your remote control’s ID is set to 0 or to the projector’s ID; see page 132.
- Make sure you are within about 33 feet (10 meters) of the projector and within range of the projector’s front or back sensor (approximately 20° to the left or right and 40° above or below).
- Dim the room lights and turn off any fluorescent lights. Make sure the projector is not in direct sunlight. Strong lighting, especially fluorescent lights, may affect the projector’s infrared receivers. Also, turn off any nearby equipment that emits infrared energy, such as a radiant room heater.

Where To Get Help

Epson provides the following technical support services.

Internet Support

Visit Epson’s support website at http://support.epson.com and select your product for solutions to common problems. You can download utilities and documentation, get FAQs and troubleshooting advice, or e-mail Epson with your questions.

Visit http://www.presentersonline.com to access tips, templates, and training for developing successful presentations.
**Speak to a Support Representative**

To use the Epson PrivateLine Support service, call (800) 637-7661 and enter the PIN on the included Epson PrivateLine Support card. This is the fastest way of speaking to a live representative, and it’s free. This service is available 6 AM to 6 PM, Pacific Time, Monday through Friday, for the duration of your warranty period.

You may also speak with a projector support specialist by dialing one of these numbers:

- **U.S.**: (562) 276-4394, 6 AM to 6 PM, Pacific Time, Monday through Friday.
- **Canada**: (905) 709-3839, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.

Before you call for support, please have the following information ready:

- Product name (Epson PowerLite 835p)
- Product serial number (located on the bottom of the projector)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer or video configuration
- Description of the problem

You can purchase screens, carrying cases, or other accessories from an Epson authorized reseller. To find the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at [www.epsonstore.com](http://www.epsonstore.com) (U.S. sales) or [www.epson.ca](http://www.epson.ca) (Canadian sales).
Software Installation

The EasyMP software CD-ROM includes the software you need to use the projector’s EasyMP features—for presenting over a wireless network, transferring PowerPoint presentations to a memory card, and monitoring the projector from a remote location.

Windows System Requirements

Before you install the software, make sure your computer meets these requirements:

- Microsoft Windows 98, Me, 2000, or XP
- 802.11g or 802.11b network card or wireless adapter (to use EMP NS Connection)
- IBM® compatible PC with at least a Pentium® III 700 MHz processor
- At least 256MB of RAM
- At least 128MB of free hard disk space
- SVGA (800 × 600) or better display adapter and monitor; XGA (1024 × 768 recommended)

Note
You can present over a wireless network from a Macintosh running OS X, but you can only monitor the projector from a remote location using a Windows system.
Macintosh System Requirements

Before you install the software, make sure your Macintosh meets the following requirements:

- Macintosh OS X 10.2.4 or later
- AirPort (802.11b) or AirPort Extreme (802.11g) wireless network interface
- Power Macintosh series, iMac, PowerBook, or iBook series
- At least 256MB of RAM
- At least 128MB of free hard disk space
- SVGA (800 × 600) or better display adapter and monitor; XGA (1024 × 768 recommended)
Installing the Software on a Windows System

Follow these steps:

1. Insert the EasyMP software CD-ROM in your computer’s CD-ROM or DVD drive. You see this screen:

   ![EasyMP Software Installation Screen]

2. Click **Install**, then follow the on-screen instructions to install your projector software.

   If you see a message that the Epson GDI Monitor Driver has not passed Windows Logo testing, click **Continue Anyway**.

3. When installation is complete, close the installation window.
Installing the Software on a Macintosh

Follow these steps to install EMP NS Connection:

1. Insert the EasyMP software CD-ROM in your drive.

2. If necessary, double-click the Epson CD-ROM icon to open its window.

3. Double-click the Installer for Mac OS X icon. You see this screen:

4. Click Install, then follow the on-screen instructions to install the software.

5. When installation is complete, close the installation window.
Projector Installation

This appendix provides guidelines on installing the projector in a permanent location, such as a theater or conference room.

The projector can be installed for four different viewing setups: front projection, ceiling mounting, rear projection onto a semi-transparent screen, or rear/ceiling projection, as shown:

To project from overhead, you’ll need the optional ceiling mounting hardware; see page 13 for ordering information. You’ll also need to select Front/Ceiling or Rear/Ceiling as the Projection option of the projector’s Extended menu to flip the image upside-down. To project from the rear, onto a semi-transparent screen, select Rear or Rear/Ceiling (see page 134).

If you’re mounting the projector on the ceiling and you place it above screen level, you’ll have to tilt the projector down to position the image on the screen. This causes the image to lose its square shape.

warning
When installing or adjusting the ceiling mount, do not use adhesives to prevent the screws from loosening and do not use any type of oil or lubricant. These may cause the projector casing to crack and the projector may fall, causing serious injury and serious damage to the projector.
You can correct the distortion using the **Keystone** function in the projector’s menu system (see page 123) or the keystone buttons on the projector’s control panel.

If you place the projector so that the base of the lens is level with the bottom of the screen, the image should be square and you won’t have to adjust it. If you place the lens lower than the bottom of the screen, you’ll have to tilt the projector upward if you want to fill the whole screen with the image.
Technical Specifications

**General**

<table>
<thead>
<tr>
<th>Specification</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of display</td>
<td>Poly-silicon TFT active matrix</td>
</tr>
<tr>
<td>Size of LCD panels</td>
<td>Diagonal: 0.8 inches (20.3 mm)</td>
</tr>
<tr>
<td>Resolution (native format)</td>
<td>1024 × 768 pixels (XGA)</td>
</tr>
<tr>
<td>Color reproduction</td>
<td>24 bit, 16.8 million colors</td>
</tr>
<tr>
<td>Brightness</td>
<td>3000 lumens (High Brightness mode)</td>
</tr>
<tr>
<td></td>
<td>2200 lumens (Low Brightness mode)</td>
</tr>
<tr>
<td>Contrast ratio</td>
<td>600:1</td>
</tr>
<tr>
<td>Image size</td>
<td>30 to 300 inches (0.8 to 7.6 meters)</td>
</tr>
<tr>
<td>Projection distance</td>
<td>2.8 to 48.3 feet (0.9 to 14.7 meters)</td>
</tr>
<tr>
<td>Projection methods</td>
<td>Front, rear, upside-down (ceiling mount)</td>
</tr>
<tr>
<td>Internal sound system</td>
<td>5 W monaural</td>
</tr>
<tr>
<td>Optical aspect ratio</td>
<td>4:3 (horizontal:vertical)</td>
</tr>
<tr>
<td>Zoom ratio</td>
<td>1:1.6</td>
</tr>
<tr>
<td>Noise level</td>
<td>28 dB or 34 dB</td>
</tr>
<tr>
<td></td>
<td>(depends on the Brightness Control setting in the Setting menu)</td>
</tr>
<tr>
<td>Keystone correction</td>
<td>Automatic (vertical and horizontal); manual adjustment capability ±45° (vertical) and ±25° (horizontal)</td>
</tr>
<tr>
<td>Mouse compatibility</td>
<td>Supports USB</td>
</tr>
</tbody>
</table>
**Projection Lamp**

- **Type**: UHE (Ultra High Efficiency)
- **Power consumption**: 200 W
- **Lamp life**:
  - Approx. 2000 hours (High Brightness mode)
  - Approx. 3000 hours (Low Brightness mode)
- **Part number**: V13H010L31

---

**Remote Control**

- **Range**: 33 feet (10 meters)
- **Batteries (2)**: Alkaline AA

---

**Dimensions**

- **Height**: 4.5 inches (114 mm), feet retracted
- **Width**: 14.4 inches (365 mm)
- **Depth**: 11.0 inches (280 mm)
- **Weight**: 10.4 lb (4.7 kg)

---

**Electrical**

- **Rated frequency**: 50/60 Hz AC
- **Power supply**:
  - 100 to 120 VAC, 3.6 A
  - 200 to 240 VAC, 1.6 A
- **Power consumption**:
  - Operating: 310 W

---

**Environmental**

- **Temperature**:
  - Operating: 41 to 95 °F (5 to 35 °C)
  - Storage: 14 to 140 °F (-10 to 60 °C)
- **Humidity**:
  - Operating: 20 to 80% RH
  - Storage: 10 to 90%
- **Operating Altitude**: Up to 7500 feet (2,286 meters)

---

*note*

Turn off this product when not in use to prolong the life of the projector.
**Safety**

United States  
FCC 47CFR Part 15B Class B (DoC)  
UL60950 Third Edition

Canada  
ICES-003 Class B  
CSA C22.2 No. 60950 (cUL)

CE Marking  
Directive 73/23/EEC  
Directive 89/336/EEC  
IEC 60950 Third Edition  
EN 55022, EN 55024

Pixelworks™ DNX™ ICs are used in this projector.

**Compatible Video Formats**

The projector supports NTSC, PAL, and SECAM international video standards, as well as the monitor display formats listed below.

To project images output from a computer, the computer’s video card must be set at a refresh rate (vertical frequency) that’s compatible with the projector. Some images are automatically resized to display in the projector’s “native” format (XGA). The frequencies of some computers may not allow images to display correctly; see your computer’s documentation for details.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Refresh Rate (Hz)</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA EGA</td>
<td>70</td>
<td>640 × 350¹</td>
</tr>
<tr>
<td>VGA—60</td>
<td>60</td>
<td>640 × 480²</td>
</tr>
<tr>
<td>VESA—72</td>
<td>72</td>
<td>640 × 480²</td>
</tr>
<tr>
<td>VESA—75</td>
<td>75</td>
<td>640 × 480²</td>
</tr>
<tr>
<td>VESA—85</td>
<td>85</td>
<td>640 × 480²</td>
</tr>
<tr>
<td>SVGA—56</td>
<td>56</td>
<td>800 × 600²</td>
</tr>
<tr>
<td>SVGA—60</td>
<td>60</td>
<td>800 × 600²</td>
</tr>
<tr>
<td>SVGA—72</td>
<td>72</td>
<td>800 × 600²</td>
</tr>
<tr>
<td>SVGA—75</td>
<td>75</td>
<td>800 × 600²</td>
</tr>
<tr>
<td>SVGA—85</td>
<td>85</td>
<td>800 × 600²</td>
</tr>
<tr>
<td>SVGA—120</td>
<td>120</td>
<td>800 × 600²</td>
</tr>
<tr>
<td>Mode</td>
<td>Refresh Rate (Hz)</td>
<td>Resolution</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>XGA—60</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—70</td>
<td>70</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—75</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—85</td>
<td>85</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—100</td>
<td>100</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>XGA—120</td>
<td>120</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SXGA1—70</td>
<td>70</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA1—75</td>
<td>75</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA1—85</td>
<td>85</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA1—100</td>
<td>100</td>
<td>1152 × 864*</td>
</tr>
<tr>
<td>SXGA2—60</td>
<td>60</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—75</td>
<td>75</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA2—85</td>
<td>85</td>
<td>1280 × 960*</td>
</tr>
<tr>
<td>SXGA3—60</td>
<td>60</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—75</td>
<td>75</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>SXGA3—85</td>
<td>85</td>
<td>1280 × 1024*</td>
</tr>
<tr>
<td>UXGA—60</td>
<td>60</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>UXGA—65</td>
<td>65</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>UXGA—70</td>
<td>70</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>UXGA—75</td>
<td>75</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>UXGA—80</td>
<td>80</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>UXGA—85</td>
<td>85</td>
<td>1600 × 1200*</td>
</tr>
<tr>
<td>MAC13</td>
<td>67</td>
<td>640 × 480*</td>
</tr>
<tr>
<td>MAC16</td>
<td>75</td>
<td>832 × 624*</td>
</tr>
<tr>
<td>MAC19</td>
<td>75</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>MAC21</td>
<td>75</td>
<td>1152 × 870*</td>
</tr>
<tr>
<td>NTSC</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>NTSC 4:43</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>N-PAL</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>M-PAL</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>PAL—60</td>
<td>60</td>
<td>—</td>
</tr>
<tr>
<td>SECAM</td>
<td>50</td>
<td>—</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>60</td>
<td>1024 × 576*</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>60</td>
<td>1024 × 576*</td>
</tr>
<tr>
<td>SDTV (480i)</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>60</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SDTV (625i)</td>
<td>50</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>SDTV (625p)</td>
<td>50</td>
<td>1024 × 768</td>
</tr>
</tbody>
</table>

*The image is resized using Epson’s SizeWise™ Technology.
Notices

This appendix includes safety instructions and other important information about your Epson PowerLite projector.

Important Safety Instructions

Follow these safety instructions when setting up and using the projector:

- Do not place the projector on an unstable cart, stand, or table.
- Do not use the projector near water or sources of heat.
- Use the type of power source indicated on the projector. If you are not sure of the power available, consult your dealer or power company.
- Place the projector near a wall outlet where the plug can be easily unplugged.

Placez l’appareil près d’une prise de courant où la fiche peut être débranchée facilement.

- Insert the projector’s three-wire grounding-type plug into a properly grounded outlet. If you have a two-prong outlet, contact an electrician to replace it. Do not hold the plug with wet hands.
- Take the following precautions for the plug. Failure to comply with these precautions could result in sparks or fire: Do not insert the plug into an outlet with dust present. Insert the plug firmly into the outlet.
- Do not overload wall outlets, extension cords, or integral convenience receptacles. This can cause fire or electric shock.
- Do not place the projector where the cord can be walked on. This may result in fraying or damage to the plug.
- Unplug the projector from the wall outlet before cleaning. Use a damp cloth for cleaning. Do not use liquid or aerosol cleaners.
- Do not block the slots and openings in the projector case. They provide ventilation and prevent the projector from overheating. Do not operate the projector on a sofa, rug, or other soft surface, or in a closed-in cabinet unless proper ventilation is provided.
Never push objects of any kind through the cabinet slots. Never spill liquid of any kind into the projector.

Except as specifically explained in this User’s Guide, do not attempt to service this product yourself. Refer all servicing to qualified personnel. Opening or removing covers may expose you to dangerous voltages and other hazards.

Unplug the projector from the wall outlet and refer servicing to qualified service personnel under the following conditions: When the power cord or plug is damaged or frayed. If liquid has been spilled into the projector, or if it has been exposed to rain or water. If it does not operate normally when you follow the operating instructions, or if it exhibits a distinct change in performance, indicating a need for service. If it has been dropped or the housing has been damaged.

The lamp(s) in this product contain mercury. Please consult your state and local regulations regarding disposal or recycling. Do not put in the trash.

Unplug the projector during lightning storms or when it will not be used for extended periods.

Do not place the projector and/or remote control on top of heat-producing equipment or in a hot location.

If you use the projector in a country other than where you purchased it, use the correct power cord for that country.

Do not stand on the projector or place heavy objects on it.

Do not use the projector outside of the required temperature range of 41 to 95 °F (5 to 35 °C). Doing so may cause an unstable display and could lead to projector damage.

Do not store the projector outside of the required temperature range of 14 to 140 °F (-10 to 60 °C) or in direct sunlight for long periods of time. Doing so may cause damage to the case.

**WARNING:** This product contains chemicals, including lead, known to the State of California to cause birth defects or other reproductive harm. Wash hands after handling.
Remote Control Information

You can operate the projector by remote control via a line-of-sight infrared (IR) receiver at the front and rear of the projector. The projector may not respond to remote control commands under the following conditions:

- There is an object between the remote control IR emitter and the IR receiver on the projector.
- Ambient light is too bright.
- Certain types of fluorescent lighting are used.
- A strong light source shines into the IR receiver.
- Other equipment that emits infrared energy, such as a radiant room heater, is in the room.

These conditions commonly cause problems for most infrared-controlled equipment. Try the following:

- The remote control’s batteries may be low on power; replace them.
- Dim the ambient lighting and/or turn off any fluorescent lights.
- Close any window coverings and/or move the projector out of direct sunlight.
- Turn off other equipment that emits infrared energy.
Declaration of Conformity

According to 47CFR, Part 2 and 15, Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers

We: Epson America, Inc.
Located at: 3840 Kilroy Airport Way
            MS: 3-13
            Long Beach, CA 90806-2469

Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed, is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: Epson
Type of Product: Projector
Model: EMP-835
Marketing Name: PowerLite 835p
FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.
Warranty

Epson America, Inc. Limited Warranty

Basic Two-Year Warranty and 90-Day Lamp Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the original retail purchaser of the Epson product enclosed with this limited warranty statement that the product, if purchased new and operated in the United States or Canada, conforms to the manufacturer’s specifications and will be free from defects in workmanship and materials for a period of two (2) years from the date of original purchase (except that the warranty period is 90 days for projector lamps). For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: If you elect carry-in warranty service, please bring the product securely packaged in its original container or an equivalent, along with proof of the date of original purchase, to your Epson Dealer or Epson Customer Care Center. Epson will, at its option, repair or replace on an exchange basis the defective unit, without charge for parts or labor. When warranty service involves the exchange of the product or of a part, the item replaced becomes Epson property. The exchanged product or part may be new or previously refurbished to the Epson standard of quality, and at Epson’s option, the replacement may be another model of like kind and quality. Epson’s liability for replacement of the covered product will not exceed the original retail selling price of the covered product. Exchange or replacement products or parts assume the remaining warranty period of the product covered by this limited warranty. However, each replacement lamp carries the limited 90-day warranty stated above.

What This Warranty Does Not Cover: This warranty does not apply to refurbished or reconditioned products. This warranty covers only normal consumer use in the United States and Canada. 24-hour-per-day use causes unusual strain and is not considered normal use. This warranty does not cover consumables (e.g., fuses), other than lamps. This warranty is not transferable. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. Postage, insurance, or shipping costs incurred in presenting your Epson product for carry-in warranty service are your responsibility. If a claimed defect cannot be identified or reproduced in service, you will be held responsible for costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. IN THE EVENT THE REMEDIES ABOVE FAIL, EPSON’S ENTIRE LIABILITY SHALL BE LIMITED TO A REFUND OF THE PRICE PAID FOR THE EPSON PRODUCT COVERED BY THIS LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights, and you may also have other rights, which vary from jurisdiction to jurisdiction.

To locate the Authorized Epson Servicer nearest you, call the Epson Connection℠ at (800) 637-7661+ PIN or (562) 276-4394 in the U.S. and (905) 709-3839 in Canada or write to: Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012.


Index

A
A/V Mute, 37, 131, 171
About menu, 165 to 166, 171
Access Point mode, 68 to 79, 89 to 92
Access point, checking IP address of, 76 to 77
Accessories, 13, 182
Ad Hoc mode, 62 to 68
Adapter, Macintosh, 13, 48
Air filter
    cleaning, 162 to 163
    ordering, 13
    replacing, 163 to 164
AirPort, configuring for wireless, 67 to 68, 77 to 79
Anti-theft device, 13, 17
Aspect ratio, 189
ATA flash cards, 111
Audio
    adjusting volume, 126
    connecting equipment, 57 to 58
    problems, troubleshooting, 176
    turning off (using A/V Mute), 37
    using with scenarios, 105
Authentication, 81, 82
Auto button, 28
Auto Setup setting, 122
Autorun setting, 112 to 113

B
Background color setting, 105, 128
Bands, vertical, 175
Batteries, installing, 33
Blackboard, projecting on, 40 to 41
Blank screen, 21 to 23
Blurry image, 174 to 175
bmp, 116
Brightness, 189
Brightness setting, 121
Browser, monitoring projectors with, 149 to 150

C
Cables
    included with projector, 12
    mouse, 49
    ordering, 13
    remote control cable set, 13
    S-video, 13, 53
    VGA-to-component, 47
Camera, see Digital camera
Capturing image, 130 to 131
CardPlayer, 99 to 100
Carrying case, 13, 166
Ceiling mount, 13, 187 to 188
Cleaning
    air filter, 162 to 163
    lens, 162
    projector case, 162
CMYK color format, 116
Color
    correcting with Wall Shot, 40 to 41
    problems, 176
    settings, 125
Color Mode setting, 120, 125
CompactFlash memory cards, 111
Component video
cable, 51
Component video cable, 13
Composite (RCA) video cable, 51 to 52
Computer
    connecting to, 46 to 48
    correcting images, 28
    selecting source, 20
Connecting projector
to a computer, 46 to 48
to a digital camera, 56
to an external drive, 56
to an external monitor, 50
to audio equipment, 57 to 58
to video equipment, 51 to 55
Continuous play setting, 98, 113
Contrast setting, 121

D
Declaration of Conformity, 196
Default settings, restoring, 119
Desktop adapter, Macintosh, 13, 48
DHCP, 70, 75, 78, 178
Digital camera
  connecting to, 56
  projecting images from, 99 to 100
Direct Power On, 30
Display order setting, 99
Distance from projector to screen, 16, 189
Documentation, 10
DPOF, 116
Drive, external, 56, 100 to 101
DVD player, connecting, 51 to 55

E
EasyManagement
  configuring the projector, 62 to 64,
    68 to 81, 138 to 139
  installing software, 183 to 186
  monitoring the projector, 139 to 145
  problems, 177 to 180
  receiving e-mail alerts, 145 to 148
EasyMP
  e-mail alerts, setting up, 145 to 148
  problems, 179 to 180
  software, 183 to 186
  starting, 60 to 61
  web browser, monitoring projector with,
    149 to 150
Electrical specifications, 190
E-mail alerts, 145 to 148
EMP Monitor
  installing software, 185
  problems, 177
  using, 139 to 145
EMP NS Connection
  configuring projector for, 68 to 82
  creating password for, 64, 70
  disconnecting, 86
  encrypting presentation, 86
  entering keyword, 86
  installing software, 183 to 186
  problems, 177 to 179
  projecting wirelessly, 59 to 92
  switching between users, 92
  using, 83 to 92
EMP SlideMaker
  checking scenarios, 110
  converting PowerPoint files, 102 to 103
  creating scenarios, 102 to 109
  problems, 179 to 180
  setting up transitions, 108 to 109
  transferring scenarios to memory card,
    111 to 113
Encryption, 66, 73, 80 to 81, 86
Environmental specifications, 190
Epson
  accessories, 13, 182
  presentation tips, 10
  PrivateLine Support, 11, 182
  technical support, 10, 181 to 182
ESSID, 64, 66, 73, 78, 85, 178
Exporting projector groups, 156 to 157
External drive, projecting from, 56, 100 to 101
E-Zoom button, 38

F
FCC compliance statement, 197
Filter, see Air filter
Focusing image, 25
Freeze button, 37
G

Gateway address, checking, 76
Group, saving menu settings as, 122
Groups, projector
  connecting to, 154 to 156
  creating, 151 to 153
  exporting, 156 to 157
  importing, 158 to 159

H

HDTV images, video formats, 192
Height of image, adjusting, 24
Help system, using, 168
Help, Epson, 10, 181 to 182
HP OpenView, 71, 137

I

ID setting, 132 to 133
Image
  adjusting, 24 to 28, 120 to 125
  blurry, 174 to 175
  capturing and saving in projector, 130 to 131
  correcting shape, 26 to 27, 36, 123, 174
  fitting on screen, 122, 173
  height, adjusting, 24
  problems with, 171 to 176
  projecting on walls, 40 to 41
  raising, 24
  rotating, 98, 100, 101, 114
  selecting source, 20, 34 to 35, 52, 53, 55
  size and projection distance, 16, 189
  turning off (using A/V Mute), 37
  zooming, 25, 38
Image menu, 120 to 123
Importing projector groups, 158 to 159
Infrastructure mode, see Access Point mode
Input signal, selecting, 20, 34 to 35, 52, 53, 55
Installing projector, 187 to 188
Installing software, 183 to 186
IP Connect Mode, 89 to 91

J

jpg, 116

K

Kensington anti-theft device, 13, 17
Keystone correction, 26 to 27, 123, 174, 189
Keyword, 64, 70, 86

L

Lamp
  number of hours used, 171
  ordering, 13
  replacing, 163 to 166
  specifications, 190
  status light, 169 to 170
Lamp timer, resetting, 165 to 166
Language setting, 134, 168
Laptop computer
  connecting to, 47
  display problems, 21 to 23, 171 to 173
  selecting source, 20, 47
LEAP authentication, 82
Lens, cleaning, 162
Lights, status, 169 to 170
Living Room color mode, 120, 125
Logo, saving on projector, 130 to 131

M

Macintosh desktop adapter, 13, 48
Manuals, 10
Memory card
  compatible card types, 111
  inserting in projector, 96
  removing from projector, 96
  transferring scenarios to, 111 to 113
Memory Stick, 111
Menus
   About, 165 to 166, 171
   changing settings, 118 to 119
   default settings, restoring, 119
   Image, 120 to 123
   Signal, 121 to 123
   User’s Logo, 130 to 131
Microdrive, 111
Monitor, connecting external, 50
Monitoring projector
   EMP Monitor, 139 to 145
   HP OpenView, 137
   receiving e-mail alerts, 145 to 148
   remote setup options, 134
   web browser, 149 to 150
Mouse
   compatibility, 189
   connecting cable for remote, 49
   using remote control as, 41
Movie files, using in scenarios, 106 to 108
   MPEG, 116
   mpg, 116
   m1k, 116
Network
   managing projector remotely, 137 to 148
   setting, 142, 144
   wireless, 59 to 93
Network card, 183
Network settings, configuring, 62 to 64,
   68 to 81, 138 to 139, 145 to 148
New Hardware Wizard, 19
No Signal message, 21, 171 to 173
Noise level, 189
Notebook computer
   display problems, 171 to 173
   Numeric keypad, using, 63, 128
O
   Operation Lock setting, 131
   Optical aspect ratio, 189
   Options for projector, 13
P
   Password
      protection, 127 to 129
      remote access, 64, 70
      request code, 129
   PC card, 111
   PCMCIA slot, 111
   Picture source, selecting, 20, 34 to 35,
      52 to 53, 55
   Picture, see Image
   P-in-P image, 38 to 39
   png, 116
   pNS Connection, see EMP NS Connection
   Pointer tool, using, 43 to 44
   Positioning
      image, 24
      projector, 16 to 17
   Power
      button, 19
      light, 19, 169 to 170
      specifications, 190
   PowerPoint files
      adding slides to a scenario, 106 to 107
      converting to scenarios, 102 to 103
      presenting, 113 to 114
      problems, 179 to 180
   Presentation color mode, 120, 125
   Presentations
      computer, 20, 28, 46 to 49
      digital camera, 56, 99 to 100
      room conditions, 32
      tips and training, 10
      using the pointer tool, 43 to 44
      video, 20, 51 to 55
      wireless, 59 to 92
   Presenters Online, 10, 181
Preset setting, 122
Pre-shared key, 81
PrivateLine Support, 11, 182
Problems
  color, 176
  connecting wirelessly, 84 to 85, 177 to 179
  image, 171 to 176
  monitoring projector, 177
  no signal, 21, 171 to 173
  remote control, 181
  scenarios, 179 to 180
  sound, 176
  using on-screen help, 168
Progressive format, 116
Projecting without screen, 40 to 41
Projection lamp, see Lamp
Projector
  carrying case, 13, 166
  cleaning, 162
  connections, see Connecting projector
  disabling buttons, 131
  distance from screen, 16, 189
  groups, 151 to 159
  ID, setting, 132
  installing, 187 to 188
  lamp specifications, 190
  monitoring remotely, 134, 137 to 150
  multiple projectors, controlling, 132 to 133
  options, 13
  password protection, 127 to 129
  positioning, 16 to 17
  resolution, 189
  specifications, 189 to 191
  transporting, 166
  troubleshooting, 167 to 170
  turning off, 29
  turning on, 18 to 19
  unpacking, 12
  viewing information about, 171
PSK, 81

Q
Quick Corner, 36
Quick Setup, 135 to 136

R
Raising image, 24
Rear-screen projection, 134, 187 to 188
Registration, 11
Remote control
  A/V Mute button, 37
  as wireless mouse, 41
  battery used, 190
  checking ID, 133
  connecting cable for mouse, 49
  correcting color, 40 to 41
  E-Zoom button, 38
  Freeze button, 37
  information, 195
  numeric keypad, using, 63, 128
  pointer tool, using, 43 to 44
  problems, 181, 195
  range, 190
  replacing batteries, 33
  running slideshow with, 113 to 114
  setting ID, 133
  specifications, 190
  storing, 32
  switching sources, 34 to 35
  troubleshooting, 181
  turning on, 19, 32
Removing
  memory card, 96
  wireless card, 93
Replacing lamp, 163 to 166
Request code, password, 129
Resetting lamp timer, 165 to 166
Resetting menu options, 119
Resize image, 123
Resolution, 122, 189
Rotating the image, 98, 100, 101, 114
S

Safety
instructions, 193 to 194
specifications, 191

Scenarios
adding movie files, 106 to 108
adding sound, 105
background color, 105
cells, 103, 107
converting PowerPoint files, 102 to 103
creating, 102 to 109
default location, 105
editing on the projector, 114 to 115
exiting, 98, 114
presenting on the projector, 113 to 114
previewing, 110
problems, 179 to 180
rearranging, 107
running automatically, 112 to 113
transferring to memory card, 111 to 113
transitions, 108 to 109

Screen
blank, 21 to 23
distance from projector, 16
ordering, 13
startup screen, creating, 130 to 131

Screen image, see Image

Screen switching time setting, 98

Security
Kensington lock, 13
password protection, 127 to 129

Sharpness setting, 121

Signal menu, 121 to 123
sit (presentation file type), 116
Sleep Mode, 19, 134, 169, 171
SlideMaker, see EMP SlideMaker

Slides
displaying on the fly, 97 to 99
hiding, 114 to 115
rearranging, 114 to 115

SmartMedia cards, 111
SNMP, 137, 138
Software installation, 183 to 186

Sound
adding to scenarios, 105
adjusting, 126
troubleshooting, 176

Source
selecting, 20, 34 to 35
viewing, 171

Speaker, specifications, 189
Speakers, connecting, 58
Special effects, adding to slide transitions, 99, 109

Specifications
brightness, 189
dimensions, 190
electrical, 190
environmental, 190
general, 189
lamp, 190
remote control, 190
resolution, 189
safety, 191
sRGB color mode, 121, 125

Standby Mode setting, 134, 142, 144

Startup screen user’s logo, see User’s Logo

Startup screen, creating, 130 to 131

Status lights, 169 to 170
Support, see Technical support

S-video cable, 13

Switching between users, 92
Switching picture source, 20, 34 to 35
Sync setting, 122

Synchronization, adjusting, 28, 175
T
Technical support, 10, 181 to 182
Temperature
requirements, 190
status light, 169 to 170
Theatre color mode, 120, 125
Thumbnails, scenario, 106
Tone, adjusting, 126
Tracking, adjusting, 28, 175
Transitions, scenario, 108 to 109
Transporting projector, 166
Trap IP address, 71
Troubleshooting
blank screen, 21 to 23, 171 to 172
cut-off image, 173
distorted image, 26 to 27
EasyManagement, 177 to 180
image and sound problems, 171 to 176
no signal, 21, 171 to 173
projector problems, 167 to 170
remote control problems, 181
wireless projection problems, 84 to 85, 177 to 179
Turning off picture (using A/V Mute), 37
Turning off projector, 29
U
Unpacking projector, 12
USB cable, 12, 49
User’s Logo menu, 130 to 131
V
VCR, connecting, 51 to 55
Video
cables, 12, 13, 51
connecting video equipment, 51 to 55
display settings, viewing, 171
formats, supported, 191 to 192
selecting source, 20, 34 to 35, 52, 53
Video Signal setting, 123
Volume, adjusting, 126
W
Wall Shot, 40 to 41
Warning lights, 169 to 170
Warranty, 11, 198
Web browser, monitoring projector with, 149 to 150
WEP encryption, 80 to 81
Windows, configuring for wireless, 64 to 66, 71 to 76
Wireless
connecting manually, 89 to 91
e-mail alerts, 145 to 148
LEAP authentication, 82
network card, 60, 93, 183
presentation, 59 to 92
problems, 177 to 179
projector groups, 151 to 159
WEP encryption, 80 to 81
WPA security, 81
Wireless, mouse, 41, 49
WPA, 81
Z
Zoom ratio, 189
Zooming image, 25, 38
**Front/Top**

- Air exhaust vent
- Control panel
- Lens cover
- Remote control receiver and Quick Setup sensor
- Handle
- Air filter
- Adjustable foot
- Speaker

**Back**

- USB ports (type A and B)
- Computer 2/Component and related audio ports
- Card slot
- Ethernet port
- Remote control receiver
- Power inlet
- Video port and related audio ports
- S-Video port and related audio ports
- Security lock
- Rear adjustable foot
- Monitor-out port
- Audio-out port
- Control port for service use only

**Remote Control**

- **E-Zoom button**: Enlarges section of image
- **Power button**: Turns the projector on and off
- **On/Off switch**: Turns the remote control on and off
- **Pointer/Mouse button**: Moves cursor on the screen
- **Enter and Esc**: Use as mouse buttons or to make menu selections
- **Pointer button**: Selects pointer or drawing tool
- **Help button**: Provides on-screen help
- **Source buttons**: Switch between equipment connected to projector ports
- **Auto button**: Optimizes tracking, sync, resolution, and position
- **Preset button**: Retrieves saved settings for Video menu
- **Volume controls**: Control sound
- **ID button**: Sets remote control ID code
- **Num button**: Enables number keypad
- **Preview button**: Displays active image sources
- **Wall Shot button**: Corrects color when projecting on wall or blackboard
- **Menu button**: Activates menu system
- **Power button**: Turns the projector on and off
- **Menu button**: Activates menu system
- **A/V buttons**: Control image and sound
- **Light button**: Illuminates remote control buttons
- **Enter and Esc**: Use as mouse buttons or to make menu selections
- **Light button**: Moves cursor on the screen
- **Remote control receiver and Quick Setup sensor**: Enables number keypad
- **Remote control receiver**: Turns the remote control on and off

**Computer 1/Component and related audio ports**

**Computer 2/Component and related audio ports**